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Preface

Welcome to the Oracle Customer Relationship Management, Release 11i, suite of 
applications.

This Concepts and Procedures provides information and instructions to help you 
work effectively with Oracle TeleSales.

This preface explains how Concepts and Procedures is organized and introduces 
other sources of information that can help you.

Intended Audience
This guide is aimed at the following users:

■ TeleSales Administrators

■ TeleSales Managers

■ TeleSales Agents

Structure
This manual contains the following chapters: 

“Understanding Oracle TeleSales provides overviews of the application and its 
components, explanations of key concepts, features, and functions, as well as the 
application’s relationships to other Oracle or third-party applications.

“Using Oracle TeleSales” provides process-oriented, task-based procedures for 
using the application to perform essential business tasks. 
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Conventions
The following conventions are also used in this manual:

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology.

This documentation is available in HTML format, and contains markup to facilitate 
access by the disabled community. Standards will continue to evolve over time, and 
Oracle Corporation is actively engaged with other market-leading technology 
vendors to address technical obstacles so that our documentation can be accessible 
to all of our customers. For additional information, visit the Oracle Accessibility 
Program web site at http://www.oracle.com/accessibility/. 

Convention Meaning

  .
  .
  .

Vertical ellipsis points in an example mean that information not 
directly related to the example has been omitted.

. . . Horizontal ellipsis points in statements or commands mean that 
parts of the statement or command not directly related to the 
example have been omitted

boldface text Boldface type in text indicates a term defined in the text, the glossary, 
or in both locations.

< >  Angle brackets enclose user-supplied names.

[ ] Brackets enclose optional clauses from which you can choose one or 
none.
xiv



Understanding Oracle TeleSales

This topic group provides an overview of the application and its components, 
explanations of key concepts, features and functions, as well as the application’s 
relationship to other Oracle or third-party applications.

About the Oracle TeleSales User Interface
Oracle TeleSales user interface is based on Oracle Forms technology. For an 
understanding of the user interface, see the Oracle Applications User’s Guide.

Additional help is available on:

■ Searching in Oracle TeleSales

■ Manipulating and copying table data

About Searching In Oracle TeleSales
This topic covers the different ways of searching for information in Oracle TeleSales:

■ Fast searches using the List of Values

■ Searching on multiple criteria via the Universal Search window

■ Finding text

Note: Oracle TeleSales does not support the Query Enter / Query 
Run method of searching common to most Oracle applications.
Understanding Oracle TeleSales 1



About Searching In Oracle TeleSales
Fast Searches Using the List of Values
The fastest way to search the Oracle TeleSales database is to use the Lists of Values 
(LOVs) provided with many fields.

A button with an ellipsis indicates a field contains an LOV:

This button appears only when you place your cursor within the field. Here is an 
example of a field with an LOV from the eBusiness Center:

Clicking the LOV button or pressing CTRL+L on your keyboard brings up the LOV 
window for your searches. 

As you can only use only one LOV field at a time, however, this type of search does 
not work well with common terms, including common names such as name John 
Smith. 

Searching for John Smith using the First Name LOV or the Last Name LOV, may 
return hundreds of John Smiths for your to sort through. In this case, you must use 
additional search criteria available via the Universal Search window. 

Searching On Multiple Criteria Via the Universal Search Window 
Use the Universal Search window to search for information using multiple search 
criteria. You can launch this window by clicking the Find (the flashlight) icon in the 
toolbar, choosing Find from the View menu, or by clicking the Find button in the 
eBusiness Center. 

Note: If you wish to search on partial words or numbers, then you 
must use the % character to indicate missing or unknown 
characters. 
2 Oracle TeleSales Concepts and Procedures 



About Creating and Using Lists
Finding Text 
You can search information displayed in dynamic tables by right clicking in the 
table and making a selection from a pop-up menu. You can search all information. 
This includes text within notes, information entered using the lists of values and 
drop-down lists, as well as information supplied by the application, such as 
opportunity numbers and account numbers. 

You can recognize a dynamic table by its striped rows and headers. Here is an 
example:

For a detailed explanation of searching within tables as well as other ways you can 
customize the presentation of data, see Manipulating Data in Your Work Queue and 
Other Dynamic Tables.

About Creating and Using Lists 
You can create lists of customers, events, leads, opportunities, and other objects for 
use in your sales activities in the Oracle TeleSales Lookup Center, which you launch 
by making a selection from the Navigator. 

For example, you may wish to create a list of hot leads, a list of open opportunities, 
and a list of customers who wish to receive collateral and enroll in events. 

To create a list, you perform a search that is similar to the complex search using the 
Universal Search window. The only difference is the last step: you save the results of 
your search as a list.

If you wish to refresh a list frequently, you can save your search criteria so you need 
not reenter them every time. This is done by clicking the Save Folder button. 
Understanding Oracle TeleSales 3



An Overview of the eBusiness Center
An Overview of the eBusiness Center
The eBusiness Center serves as the central work area for Oracle TeleSales.

Use it to create and manage customer records, leads, opportunities, and events. It is 
here you send out collateral, enroll your customers in events, and launch the Oracle 
Order Capture window where you prepare quotes and orders.

The eBusiness Center is divided into five functional areas:

1. Header
The header displays basic customer information including the primary address and 
phone number for the person or organization you are viewing. Although you can 
enter basic information about the party here, most of the entries are done in the tabs 
below.

The Party Type drop-down list determines what type of customer information you 
can view and enter. 
4 Oracle TeleSales Concepts and Procedures 



About eBusiness Center Tabs
2. Organizational Profile
When the header displays information about an organization or a business contact 
(party type of Party Relationship) this region summarizes information about the 
organization such as the number of open leads and opportunities. You cannot 
modify information here.

3. View Details For Radio Buttons
Selecting a radio button here determines what information you can edit in the 
twelve tabs below. 

4. Tabs: Enter Contact, Organization, and Purchase Information
You use these twelve tabs to enter and manage detailed information for the 
customer displayed in the header. How the information you enter here is stored in 
the database depends on the View Details For radio button you selected.

See About eBusiness Tabs for more information on each tab.

5. Telephony buttons
Use these buttons to log into incoming calls, to take a break, and to wrap up.

Before you start using the eBusiness Center, you must familiarize yourself with how 
customer information is organized. 

About eBusiness Center Tabs
The twelve tabs of the eBusiness Center is where you enter and manage detailed 
information for the customer displayed in the header. 

Which tabs are active and how the information you enter here is stored in the 
database depends on which of the View Details For radio buttons you select. For 
example, if you select the radio button with the name of the person and enter an 
address, then this address is stored in the database linked to the record of the 
person as a consumer. If you enter the same address after selecting the radio button 
labeled with the name of the person and the organization they represent, then this 
address is stored linked to this relationship and will not be visible when you are 
looking at addresses with the first radio button selected. A separate topic covers 
how customer information is organized. 

The twelve tabs are:

■ Overview
Understanding Oracle TeleSales 5



About the Overview Tab
■ Organization

■ Person

■ Address

■ Relationships

■ Accounts

■ Leads

■ Opportunity

■ Quote/Order

■ Event

■ Collateral

■ Task

About the Overview Tab
Use the Overview tab to enter the campaign the customer is calling about, to launch 
scripts, enter and view notes and interactions that pertain to the organization or 
contact. 

About the Organization Tab
The Organization tab is where you:

■ View and enter basic information about an organization, including phone 
numbers, email addresses, web site URLs, revenue, and the number of 
employees. 

■ Restrict use of phone numbers and emails.

■ Assign individuals to a sales team, enter an organization’s purchase interests, 
and view the organization’s installed base of products. 

This tab is enabled only when the header displays an organization or an 
organizational contact (party relationship).

About the Person Tab
The Person tab is where you:
6 Oracle TeleSales Concepts and Procedures 



About the Relationships Tab
■ View and enter personal information about an organizational contact or 
consumer, including phone numbers, email addresses, and web site URLs. 

■ Restrict use of personal phone numbers and emails if the individual does not 
want to be contacted.

■ Track the individual’s personal interests, job experience, education, and leisure 
activities.

This tab is disabled when you select the radio button for the organization in the 
View Details For region.

About the Address Tab
The Address tab is where you enter addresses and specify their uses. To create 
quote and orders, to ship collateral, and to enroll contacts in events, you must 
specify a bill to and ship to addresses.

The address you designate as primary here is what appears in the eBusiness Center 
header.

A single address can have multiple uses. You can specify the multiple uses for a 
single address by selecting the address on the left side of the tab, and entering the 
address uses in the Address Type column.

The following image shows the three different uses for the selected address (3129 
Pollstime Ave.). The Address Types are: Bill To, Headquarters, and Ship To. 

About the Relationships Tab
Use the Relationships tab to capture the relationships between parties in the 
database. This is where you specify one company is the subsidiary of another, that 
one of your contacts is the manager of another and where you make changes when 
a contact moves from one company to another. See Understanding Relationships for 
more detail.
Understanding Oracle TeleSales 7



About the Accounts Tab
About the Accounts Tab
Use the Accounts tab to view information about a customer’s accounts. The 
information on the Accounts tab and its subtabs may come from Oracle Receivables. 
or other accounting packages. Information on the Credit and Suspension tabs of the 
Customer Details window, which is available by clicking Details, is used by 
consulting to display information from other legacy systems. 

About the Leads Tab
Use the Leads tab and the Lead Center to manage leads for the customer displayed 
in the eBusiness center header.

This topic covers:

■ Overview

■ Refusing lead assignment

■ About lead status

■ Ranking

■ Assigning qualified leads to sales representatives

Overview 
Leads are designed to capture the initial contacts with potential customers, 
gathering just enough information to tell a sales organization if a lead merits more 
sales resources, should be set aside for a later date, or abandoned entirely. 

Agents use leads to gather information on:

■ The products a customer is interested in purchasing

■ The budget

■ Names of contacts associated with the lead

■ The time frame for the sale

■ Tasks relating to the lead

■ Notes

The person creating a lead has the option of assigning it manually to a sales agent or 
letting the CRM territory management program automatically assign the lead to a 
sales team member. 
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About the Leads Tab
Refusing Lead Assignment
A sales agent can refuse a lead assignment and reassign the lead to someone else. 

Lead Status
The progress of a lead is tracked by its status. A new lead has the status of new by 
default and must attain a status of qualified before it can be turned into an 
opportunity.

Agents can enter a status of a lead manually or let the application evaluate the 
status automatically. The application changes the status to qualified after agents 
enter information in a set of fields determined by your implementation team. These 
include project name, time frame, and budget. 

To qualify a lead, the application looks to see only if an entry has been made in the 
specified fields. It does not evaluate the quality of the lead. The automatic lead 
status assignment takes place each time the lead is saved.

In addition to entering required lead information, the agent must evaluate the 
likelihood of a particular lead turning into a sale by assigning it a rank. 

Ranking
Lead rank tracks the desirability of the lead. Agents can let the application assign 
the rank automatically by clicking the Rank button, or they can select a value 
manually from the Lead Rank drop-down list.

The application determines the quality of the lead by using a lead score card set up 
by the application administrator. The score card assigns different numbers of points 
to entries depending on desirability. For example, a time frame of 1-3 months 
receives more points than a time frame of 1 year. A budget of $1 million receives 
more points than a budget of $10,000.

Assigning Leads To Sales Representatives
Lead creators can either allow the territory assignment program to assign the leads 
to sales representatives automatically or choose the sales representatives manually. 
The sales representatives then turn the leads into new opportunities or link them to 
existing opportunities.
Understanding Oracle TeleSales 9



About the Opportunity Tab
About the Opportunity Tab
Use the Opportunity tab to view and manage sales opportunities. An opportunity 
takes the potential sale from a qualified lead through the negotiation stage. 

This topic covers:

■ Overview

■ How you create an opportunity

Overview
Use an opportunity you can track:

■ Purchase Interest: Enter Products the customer is interested in buying.

■ Sales Team: Add sales team members or let the territory management module 
assign a team.

■ Sales Credit: The sales credit the sales team members are to receive.

■ Contacts: Contacts for the opportunity.

■ Obstacles: Enter information about your competitors.

■ Closing Information. Track orders placed for won opportunities as well as 
information about competitors for lost opportunities. If an opportunity results 
in a sale, you must remember to enter closing information for an opportunity so 
the sales team can receive sales credit for their work.

■ Classification: Classify an opportunity according to categories defined by your 
implementation team. The values you enter here can be used to assign this 
opportunity to the appropriate sales team. If your company has a lead 
generation organization that forwards leads to you, then this window is likely 
to include information that they entered when the lead was created. 

■ Tasks: View and assign tasks relating to the opportunity. The tasks appear in 
the work queue of the individual you assign them to.

■ Leads: View the leads linked to the opportunity.

■ Quotes and Orders: Create and view the quotes and orders resulting from the 
opportunity.

Back to top
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About the Opportunity Tab
How You Create an Opportunity
You can create an opportunity in one of two ways:

■ From a qualified lead

■ By clicking the New button in the Opportunity tab

Creating an Opportunity from a Qualified Lead
When a sales representative attempts to create an opportunity from a lead, Oracle 
TeleSales automatically performs a check for potential duplicates. 

If the application finds a potential duplicate, the sales representative can:

■ Link the lead to the existing opportunity. 

Purchase and other information is not transferred to the matching opportunity, 
but agents can access the lead from the Leads tab of the linked opportunity.

■ Copy purchase line items to the duplicate opportunity. 

The copied items are transferred to the potential purchases in the existing 
opportunity. The copy process removes them from the lead.

The sales representative creating the new opportunity becomes the leader of the 
opportunity team. Any team member required to make modifications to 
opportunity information must be designated as "Full Access". This is done by 
selecting the Full Access Check box.

The application automatically notifies new team members of the assignment via 
their work queues.

The team members use the opportunity as a repository for information on the 
negotiations, to prepare forecasts, and assign sales credit.

A team leader can decide to create a quote for a customer at any time. Quotes can be 
configured for all of the purchase items.

Creating a New Opportunity Directly
You can create new opportunities without a prior lead, by clicking the New button 
in the Opportunity tab.

Note: Agents can link a lead to existing opportunities even if they 
do not have access to those opportunities.
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About the Quote and Order Tab
About the Quote and Order Tab
Use the Quote and Order tab to view orders placed with Oracle Order Management 
and quotes created in Oracle Order Capture. You can launch Oracle Order Capture 
from this tab to create new quotes and orders.

About the Event Tab
Use this eBusiness Center tab to enroll customers or prospects in events that have 
been set up in Oracle Marketing Online. 

This tab uses the concept of a shopping cart to let you create a single order for 
multiple events.

The tab is divided into three major regions

■ Campaign and offer entry

■ Basic event information and shopping cart

■ Payment

Campaign and Offer Entry

Making an entry in the Campaign and Offer fields narrows down the list of events 
you can choose from. You can leave these fields blank to see all events, but you 
must enter at least one campaign before you can complete the enrollment process. 
You are not limited to entering events just from one campaign but you must enter at 
least anyone.
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About the Event Tab
Basic Event Information and Shopping Cart

The Event Description and Item View regions together display the basic 
information about an event and serve as a temporary shopping cart.

Unlike many shopping carts on the Internet, this cart only serves as a temporary 
holder which is cleared out each time you switch customer records or exit the 
application.

The two regions display both events you have added to the cart and those events 
you are merely viewing.

You can tell whether an event has been added to the cart by the status of the Add to 
Cart button. The following table details the two different button states and their 
meaning.

You accumulate those events a customer is interested in attending in the cart by 
clicking Add to Cart and entering the enrollees using the Enrollees LOV. When you 
have added all the events with their enrollees to the cart, then you click the Enroll 
button to complete the enrollment and view confirmation information in a separate 
window. 

Button State Meaning

Enabled The item displayed in the Event Description and Item View 
regions has not yet been added to the shopping cart.

Disabled The item displayed in the Event Description and Item View 
regions has been added to the shopping cart. You can enroll 
contacts in the event by clicking the Enroll button.
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About the Event Tab
If you wish to see the enrollment details or detailed information about an event, 
then you click the Item Details button.

Clicking the Clear button removes an item from the shopping cart.

Item Number Indicator

The first number in the Item # fields tells you which item in the shopping cart you 
are viewing. The second number tells you how many have been added to the 
shopping cart.

Use the arrow controls to move through shopping cart items. The following table 
shows the different arrow buttons and their functions:

Note: The Mass Event Registration button is reserved for future 
use.

Button Function

Go to the next item in the cart. 

Go to the previous item in the cart.

Go to the first item in the cart.

Go to the last item in the cart.
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About the Collateral Tab
Payment

The Payment region lets you enter payment for the event.

This feature is not implemented in the current release. This means you cannot 
process payment for events within Oracle TeleSales.

About the Collateral Tab
This is where you create an order for collateral to be sent to your customers and 
prospects via the 1 to 1 Fulfillment module of CRM eBusiness Suite. This version of 
the CRM eBusiness Suite supports only electronic collateral.

Recipients and their email addresses must already be entered in the database before 
you can create an order. 

You can use the Collateral tab’s shopping cart to create an order to email collateral 
to multiple contacts at one organization. For consumers, you can add multiple 
recipients to one order only if the individuals have a relationship established within 
the database. 

The Collateral tab is divided into four major regions

■ Campaign and offer entry

■ Collateral item description

■ Collateral item quantity and intended recipient

■ Shopping cart indicator which tells you how many items you have in the order

Cover Letter and Campaign Entry
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About the Collateral Tab
The cover letter is the letter sent along with the collateral. This letter must be 
created within Oracle Marketing Online.

Making an entry in the Campaign field narrows down the list of collateral that 
appears in the Name field list of values. By leaving this field blank you can access 
the collateral associated with all campaigns, but you must enter at least one 
campaign before you can complete the order. You can order collateral associated 
with multiple campaigns in the same order.

Collateral Description 

The Collateral Description region is where you enter and view the collateral items 
you wish to email.

You use it to view both collateral you wish to add to the cart and collateral items 
already in the cart. 

Collateral Quantity and Intended Recipient

The Collateral Request region is where you enter:
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About the Collateral Tab
■ Quantity. This field applies to physical collateral only. You need not make an 
entry in this field as the current version of Oracle TeleSales does not support the 
mailing quantity of physical collateral. 

■ Information about the recipient. For electronic collateral, this is the name and 
email.

Clicking the Clear button removes the item being displayed and from the shopping 
cart.

Clicking the Add to Cart button adds the collateral item and recipient to the cart.

Shopping Cart Indicator

The shopping cart indicator tells you how many items you have in the order.

The first number in the Item fields tells you which item in the shopping cart you are 
viewing. The second number tells you how many have been added to the shopping 
cart.

Use the arrow controls to move through shopping cart items. The following table 
shows the different arrow buttons and their functions:

Button Function

Go to the next item in the cart. 

Go to the previous item in the cart.

Go to the first item in the cart.

Go to the last item in the cart.
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About the Task Tab
About the Task Tab
Use the Task tab of the eBusiness center to assign tasks pertaining to individual 
consumers, organizations, and organizational contacts.

A task you create here appears in the work queues of the individual you assign as 
the owner of the task.

If you wish to assign a task for an opportunity or a lead, then create the task in the 
Lead or Opportunity tabs instead. Where you create a task determines how a task is 
categorized in the work queue.

How Customer Information is Organized 
Oracle TeleSales uses the TCA 11i customer model which stores information about 
organizations, people, and the relationships between them as separate entities. You 
must make sure that you select the correct entity when you enter customer 
information.

This topic explains how the customer model affects the way you enter and view 
information. It covers:

■ Customer model overview

■ How the party type affects you view and enter customer information

Customer Model Overview
The database stores information you enter under three separate entities. These are 
called parties:

■ Person: Use this party type to enter personal information for both consumers 
and contacts at organizations. Personal information includes home address, 
phone, as well as quotes and orders for purchases an individual makes as a 
consumer. If your organization sells to consumers, then this is the party type 
you will be using almost exclusively.

■ Organization: Use this party type to enter information about the organization 
you are doing business with. Using this party type you can also view all of the 
quotes and orders for business purchases made by contacts at this organization.

■ Party relationship: Use this party type to enter contacts for an organization. If 
your organization sells primarily to other businesses and organizations, then 
you will be using this party type most of the time. 
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How Customer Information is Organized
Each of these parties can have its own billing and shipping addresses, telephones, 
notes, and associated tasks. 

How Party Types Affect the Way You View and Enter Customer Information
When you enter a contact at an organization using the party relationship party type, 
the application creates all three party types. 

Suppose, for example, you enter Jack Kirby, the purchasing manager at the Hall of 
Justice, as a new customer at a new organization. The application automatically 
creates three parties:

■ Person: Jack Kirby

■ Organization: Hall of Justice

■ Party Relationship: Jack Kirby purchasing manager of the Hall of Justice

The different party types are designed to hold different types of information. 

You must use the person party type to:

■ Enter and view Jack Kirby’s home address and other contact information. 

■ Enter and view his personal interests.

■ Enter and view all purchases he makes as a consumer. If Jack Kirby’s buys a 
christmas gift for his daughter Samantha, for example, then you must record 
this sale using the person party type.

■ Capture relationships between Jack Kirby and other people. Here is where you 
enter the fact that Jack Kirby is the father of Samantha Kirby.

You must use the organization party type to:

■ Enter and view general information about the Hall of Justice, Jack Kirby’s 
employer. 

Note: If you are entering addresses for a contact at an 
organization (party of type party relationship), then all addresses 
are automatically copied to the organization as well. Your 
application administrator can disable this feature by resetting the 
profile option OTS: ASSOCIATE RELATIONSHIP LOCATION TO 
ORGANIZATION to no. Note that only addresses are copied over, 
not phone numbers, email addresses and other information.
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How to Select the Party Type in the eBusiness Center
■ View quotes and orders for the organization. This includes those placed by Jack 
Kirby in his capacity as employee of the organization.

■ Manage leads and opportunities for the Hall of Justice. This includes any leads 
and opportunities on which Jack Kirby is the contact.

■ View all of the other contacts at the Hall of Justice.

■ View all of the quotes and orders for the Hall of Justice.

You must use the party relationship party type to track information relating to Jack 
Kirby’s job:

■ Enter addresses, phone numbers, and other information for Jack Kirby in his 
capacity as a purchasing manager of Hall of Justice. 

■ Capture the relationship between Jack Kirby and different organizations. If Jack 
Kirby changes jobs and moves to another organization, this is the party type 
you use to record his move.

How to Select the Party Type in the eBusiness Center 
This topic explains how you select a party type in the eBusiness Center. Before 
reading this topic, you must understand the concept of party types as described in 
How Customer Information Is Organized.

You can display up to two different party types in the eBusiness center at the same 
time: one in the header and another in the tabs below:

■ The Party Type drop-down list controls the party type in the header.

■ The View Details For radio buttons control the party type in the tabs.

The Party Type Drop-Down List Determines the Party for the Header
The Party Type drop-down list in the top left hand corner of the eBusiness Center 
determines what party type information you enter or view in the header.

The choice of party you make here also restricts what party types you can view and 
enter in the tabs below. 
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How to Select the Party Type in the eBusiness Center
If the header displays a consumer (party type of person), then you can only access 
consumer information in the tabs below. 

If the header displays an organization, then you are restricted to viewing and 
entering information for the organization. 

If the header displays an organizational contact (party of type party relationship), 
then you can use the tabs below to view and enter information for all three parties: 
consumers, organizations, and organizational contacts.

The View Details For Radio Buttons Determine the Party Type for the Tabs 
The radio buttons in the middle of the eBusiness center is where you select what 
party type you wish to view and modify in the eBusiness center tabs. 

When the header does not display a customer or organization, the radio buttons are 
not labeled:

When the header displays information on a consumer (party type of person), an 
organization (party type of organization), or a contact at an organization (party type 
of party relationship), the buttons are enabled according to the party type you can 
access in the tabs. 

For example, if the header displays information on Jack Kirby, the purchasing 
manager for the Hall of Justice, the radio buttons are labeled according to the party 
types you can view and edit using the tabs below: 

You can select:

■ Jack Kirby: To enter and view information that pertains to Jack Kirby, the party 
type Person. This includes all personal information as well as any purchases he 
makes as a consumer. 

■ Hall of Justice: To enter and view all information about the Hall of Justice, the 
party type organization. This includes organizational details as well as all leads, 
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Understanding Relationships in Oracle TeleSales
opportunities, quotes, and orders. Leads, quotes, and orders are tied to the 
organization and not the contact. 

■ Jack Kirby -- Hall of Justice, to view and enter phone numbers, addresses and 
other information for Jack Kirby when he acts in his capacity as employee of the 
Hall of Justice (party type of party relationship). 

If you selected Person from the Party Type drop-down list in the header, then you 
can access information on Jack Kirby, the consumer, only:

By selecting the Jack Kirby radio button, you can use the tabs below to enter and 
view personal information including addresses, phone numbers, and interests, as 
well as any quotes and orders Jack Kirby makes as a consumer.

Understanding Relationships in Oracle TeleSales
You can use the Relationships tab of the eBusiness center to capture both business 
and personal relationships. 

This topic covers:

■ Type of relationships you can capture

■ How to use subject and object relationships

Types of Relationships You Can Capture
You can capture:

■ Business relationships between two individuals, such as "is the manager of". 
You can establish these types of relationships for business contacts (parties of 
type Party Relationship).

■ Personal relationships between two individuals, such as "is the father of", and 
"is the son of". You can establish these relationships for consumers and business 
contacts (parties of type Person and Party Relationship).

■ Relationships between individuals and organizations, such as "is an employee 
of", "purchasing manager for". You can establish these relationships for business 
contacts (party of type Party Relationship).
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Understanding Relationships in Oracle TeleSales
■ Relationships between different organizations, such as "is a subsidiary of". You 
can establish these relationships for organizations (party of type Organization).

There is no limit to the number of relationships or the combination of relationships 
you can capture for any one person or organization. 

You can make a relationship inactive, for example, when the contact is on an 
extended vacation. Or you can terminate a relationship by entering an end date, for 
example, when an individual moves to another company. 

Capturing Relationships Using Subject and Object Relationships
Most relationships, such as "is the father of", "is a subsidiary of" describe the 
relationship in only one direction. To capture the relationship between two entities 
fully, you must also specify the reciprocal relationship. 

For example, if you specify that John is the father of Mary, then you must specify 
that Mary is the daughter of John. If you specify that ABC is the subsidiary of Walt 
Disney, then you must specify that Walt Disney is the parent company of ABC.

You can capture both sides of relationships using the Subject and Object 
relationship regions of the Relationships tab. Only the entry in the Subject region is 
required, but your organization may wish to capture both. Only entries in the 
Subject region display in the eBusiness Center header.

Here is a sample Relationships tab entry for John Bransford, an employee of 
General Technologies and the father of another customer named Cindy Martin:

Subject Relationship
Enter the main relationship here.   This is where you record that John Branford is a 
contact for General Technologies and that he is the parent of Cindy Martin. The 
relationship you specify here is the one that appears in the header. 
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About Notes
Object Relationship
Enter any secondary relationship that is tied to any existing subject relationship. If 
you just entered that John Branford is the parent of Cindy Martin, then you may 
want to capture the fact that Cindy Martin is the child of John Bransford in this 
region. 

About Notes
You can use Oracle TeleSales to keep notes on your customers, opportunities, and 
leads. 

This topic covers:

■ The two ways of creating notes

■ How context determines where you can view a note

■ How to view all notes about a customer, regardless of context

■ Searching note text

The Two Ways of Creating Notes
Any member of the sales team can enter the notes in one of two ways:

■ In the New Note field which appears in many of the eBusiness tabs as well as in 
the opportunity and lead centers.

■ In the Note window you can launch by clicking the All Notes button or 
choosing All Notes from the Tools menu.

The application automatically saves information on the note’s creator the date and 
time the note was saved. Each note is tied to the context in which a sales team 
member entered it. 

A note remains open and editable after you save it until you start working on a 
different record. If you wish to enter a second note while you are still working in the 
same record, you must have your cursor in the New Note text box and click the 
New button on the toolbar.

Context Determines Where You Can View a Note
When you enter a note, it is automatically linked to the object displayed in the tab 
or window where you create it. For example, if the Lead tab of the eBusiness Center 
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About Attaching Documents, Notes, and Web Pages
displays a lead, then the note you enter is automatically linked to that lead. This is 
true whether you enter the note in the tab itself or in the Note window.

What type of object the note is linked to determines where you can view it. This 
means that you can only view notes related to leads on the Lead tab, only notes 
related to opportunities in the Opportunity tab, and only notes related to the party 
(the customer) on the Overview tab. 

How to View All Notes for a Customer, Regardless of Context
While the context of the tabs in the eBusiness center restricts what type of note you 
can view and enter, you can view any of these types of notes, regardless of context, 
by using the All Note window. You can launch this window at any time by choosing 
All Notes from the Tools menu or by clicking the All Notes button supplied in 
several places in the application.

Searching Note Text
You can search for text within notes by displaying the list of the notes you wish to 
search in the Notes window, right-clicking in the list, and selecting Find from the 
pop-up window. See Finding Information in Dynamic Tables.

About Attaching Documents, Notes, and Web Pages
The toolbar Attachment icon, a paper clip, indicates whether you can attach a 
document, a note, or a web page to a record. 

You can make attachments in the following areas of Oracle TeleSales:

■ Persons

■ Organizations

■ Relationships

■ Addresses

■ Leads

■ Opportunities

Note: When you create an opportunity from a lead, the notes 
entered by the sales team on the lead are not copied over to the 
opportunity. 
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■ Quotes

■ Orders

■ Tasks

When the icon is dimmed, the Attachment feature is not available. When the 
Attachment feature is enabled in a form block, the icon becomes a solid paper clip. 
The icon switches to a paper clip holding a paper when the Attachment feature is 
enabled and the current record has at least one attachment.

For an understanding of how to make and view attachments, see the Working with 
Attachments chapter of the Oracle Applications User’s Guide. 
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Setting Up a Default Sales Role for Yourself
Using Oracle TeleSales

This topic group provides process-oriented, task-based procedures for using and 
completing essential business tasks.

Choosing Sales Group Roles
If you have been assigned to multiple sales groups in your organization, then you 
must choose a role each time you log into the application or launch the eBusiness 
center. Roles determine your access to information. You can have multiple roles and 
switch sales groups at any time by making a selection from the Tools menu.

So you do not have to select a sales role each time you run the application, you can 
set up a default sales group and user role by setting the profile OTS: Default User 
Role and Sales Group. See Setting Up a Default Sales Role for Yourself.

Prerequisites
You must be assigned to multiple sales groups. If you are assigned to just one sales 
group, then you do not have to choose roles to use the application.

Steps
1. If you have just logged into the application, then the Choose Role and Group 

window appears automatically.

2. If you wish to switch roles while working in the application, launch the Choose 
Role and Group window by choosing Change Role from the Tools menu.

3. Use the Role and Group List of Values (LOV) to choose a role.

4. Click OK.

5. If no roles appear in the LOV, this means no roles have been set up for you. Exit 
the application and contact your application administrator.

Setting Up a Default Sales Role for Yourself
Use this procedure to set up a set up a default sales group for yourself. This way 
you will not have to reenter the sales group each time you launch the eBusiness 
Center.
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Searching Using Universal Search
 Prerequisites
You must be assigned to multiple sales groups. If you are assigned to just one sales 
group, then you need not set up a default.

Steps
1. Navigate to Personal Profiles.

The Find Personal Profile window appears.

2. In Profile Name enter: OTS: Default User Role% 

The Personal Profiles window appears displaying the system profile OTS: 
Default User Role and Sales Group.

3. Use the User Value List of Values to select a default role and sales group.

4. Click Save on the toolbar.

Searching Using Universal Search
Click here if you wish to obtain help on using Universal Search for creating lists 
using the Lookup Center.

Click here if you wish to obtain help on using Universal Search for searching only.
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Searching Using Multiple Search Criteria with Universal Search
Searching Using Multiple Search Criteria with Universal Search
Use this procedure to search the application using multiple search criteria.

Prerequisites
None

Steps
1. Launch the eBusiness Center.

2. Place your cursor in a field corresponding to the object you wish to search for:

a. Select the tab corresponding to the object.

b. Place your cursor in one of the fields on the tab.

For example, to search for a lead, select the Lead tab and place your cursor 
in one of the lead fields, for example, the Description field.

3. Click Find in the toolbar.

4. Enter search criteria on the Basic tab.

The window displays different fields for you to search on depending on the 
information you are looking for. 

The search combines the different search criteria using the logical AND. This 
means that entering two search criteria returns only results matching both 
search criteria. For example, searching on a partial name and a partial phone 
number returns only individuals whose names and phone numbers match both.

You can search for partial numbers and words, but you must use the % sign to 
indicate missing or unknown characters. For example, a search for j%n in the 
First name field retrieves all first names starting with the letter j and ending 
with the letter n, including John, Jon, and Johann.

5. If you wish to search by criteria not available on the Basic tab, then enter 
additional search criteria on the Advanced tab:

Note: Using the Basic tab of the Universal Search window, you 
can only search on the primary address, email, and URL. If you 
wish to search on all addresses, email addresses, and URLs, then 
you must enter the search criteria on the Advanced tab.
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Using Complex Searches for Consumers, Organizations, and Contacts
a. Use the Item List of Values (LOV) to enter the criteria type. 

b. Use the Condition LOV to enter the operator. 

c. Enter the value.

For example, to search for an event costing less than $100, enter Cost for 
Item, < for the Condition and 100 for the value.

6. Click Search.

The results of your search appear below.

7. If the object you are looking for is not listed, then try searching with less 
restrictive search criteria. 

8. If the object you are looking for appears on the list, then: 

a. Select the result.

b. Click OK to display the result in the eBusiness Center.

References
Click below for more detailed procedures on searching for:

■ Consumers, Contacts, and Organizations

■ Events

■ Campaigns

Using Complex Searches for Consumers, Organizations, and Contacts
Use this procedure to search the database for consumers, organizations, or contacts 
at an organization using multiple search criteria. 

Prerequisites
The contact or organization must exist in the database.

Steps
1. Navigate to the eBusiness Center.

Note: Different fields are available depending on the type of your 
search.
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Using Complex Searches for Consumers, Organizations, and Contacts
2. From the Party Type drop-down list, select one of the following:

■ Person: if you are searching for a consumer or information about the purchases 
a contact made as a consumer

■ Party Relationship: if you are searching for a contact at an organization.

■ Organization: if you are searching for an organization.

3. Click Find (the flashlight button) in the toolbar.

The Universal Search window appears.

If you selected Person as the party type, then the Find drop-down list defaults 
to consumer.

If you selected Party Relationship as the party type, then the Find drop-down 
list defaults to Business Contact.

If you selected Organization as the party type, then the Find drop-down list 
defaults to Organization.

4. Enter multiple search criteria in the Basic tab such as area code, phone number, 
or city:

You can enter letters or partial words, but you must use the % sign to indicate 
missing or unknown characters. For example, a search for j%n in the First name 
field retrieves all first names starting with the letter j and ending with the letter 
n, including John, Jon, and Johann.

5. Click Search.

The search results display in the Results region below.

6. If the results are not satisfactory, can modify the search criteria and repeat the 
search.

7. Select the individual you wish to view from the list of results.

8. Click OK.

Note: Searches are sensitive to the punctuation used during entry. 
If someone entered 555-1212 as the phone number, then you 
cannot find that phone number by searching for 555 1212. You 
must instead search for %1212 or for 555%1212.
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Accessing Leads, Opportunities, and Other Work from Your Work Queue
The information for the individual you selected appears in the in eBusiness 
Center header.

Accessing Leads, Opportunities, and Other Work from Your Work Queue
Use this procedure to access work assigned to you from your work queue. For more 
information about using the work queue, please see Oracle Universal Work Queue 
documentation.

 Prerequisites
None

Steps
1. Click on the Work Queue button in the toolbar. This is what the button looks 

like:

The Universal Work Queue window appears.

The Queue pane on the left side of the window lists the categories of tasks.

2. Click on a category of tasks you wish to view in the right pane. For example, 
clicking on Leads displays all leads you own in a list in the right pane.

3. If you wish to search, sort, or modify the appearance of the list of tasks, see 
Manipulating Data in the Work Queue and Other Dynamic Tables.

4. Double-click on an item you wish to work on.

The item launches in the appropriate section of the application.

For example, double-clicking on a lead launches that lead in the Lead Center.

Manipulating Data in Your Work Queue and Other Dynamic Tables
Dynamic tables provide flexibility in displaying and handling data. Use them to 
track, sort, search, copy, and export data, and customize your display.

You can perform the following tasks in your Work Queue and other dynamic tables:

■ Sorting
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Finding Information in Dynamic Tables
■ Finding

■ Copying and exporting

■ Customizing layout

Sorting Information in Dynamic Tables
Use this procedure to sort work in your work queue and other tables within Oracle 
TeleSales.

 Prerequisites
You can only perform this procedure in a dynamic table such as the Universal Work 
Queue.

Steps
1. If you wish to sort on a field in the table, click on the grey dot in the column 

header.

The blue arrow that replaces the grey dot indicates a direction of order, for 
example, ascending, descending, alphabetical, or chronological order.

2. You can sort in the opposite direction by clicking the header arrow again.

Finding Information in Dynamic Tables
Use this procedure to find information in your Work Queue and other dynamic 
tables in Oracle TeleSales.

 Prerequisites
You can only perform this procedure in a dynamic table such as the Universal Work 
Queue.

Steps
1. Right-click on any cell in the table.

2. Select Find in Table from the pop-up menu.

3. Type the characters wish to search on into the text field. 

4. Indicate whether to match case, and select the direction of the search, backward 
or forward.
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5. Click Find.

6. You can click Cancel to stop a long running search.

Copying Data from Dynamic Tables
Use this procedure to copy a cell, selected rows, or all rows of data displayed in a 
dynamic table to the clipboard. You can then paste the data as tab-delimited text 
into a desktop application.

 Prerequisites
You can only perform this procedure in a dynamic table such as the Universal Work 
Queue.

Steps
1. Select the data you wish to copy.

2. Right-click on any cell in the table.

3. From the pop-up menu, choose the appropriate option.

When you insert the copied selection into a spreadsheet application, such as 
Microsoft Excel, the appropriate headers automatically migrate with the 
selection and appear as its first row. Rows are copied in a tab-delimited format.

Guidelines
Cells that display values as check marks or an X, display differently when copied 
and exported. Positive values are expressed as asterisks (*) and negative values do 
not display.

If you have customized your table to hide columns of data, these are not copied or 
exported. 

Customizing the Layout of Your Work Queue and Other Dynamic Tables
Use this procedure to adjust the layout of your Work Queue and other tables to 
accommodate your needs.

 Prerequisites
You can only perform this procedure in a dynamic table such as the Universal Work 
Queue.
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Steps
1. You can resize any column or row by placing your cursor at the edge of the 

header. When the double arrow appears, you can drag the column or row to the 
desired size.

2. If you wish to change the order the columns, then:

a. In a header, left-click and hold the mouse key down until a black box 
appears around the header. 

b. Move the header to the selected position. Allow for a delay before making 
the move.

3. If you wish to hide a column from view, then:

a. Right-click the header of the column you wish to hide.

b. Select Hide Column on the pop-up menu.

4. If you wish to display columns which are hidden, then:

a. Right-click on any column header.

b. Choose Show Column from the pop-up menu.

A list of all currently hidden columns appears. 

c. Select all or only those columns you wish to display.

5. To preserve changes you make to the table layout:

a.  Right-click a column header. 

b. From the pop-up menu, choose Customizations.

c. From the submenu, choose Save.

6. If you wish to restore default settings:

a. Right-click a column header. 

b. From the pop-up menu, choose Customizations

c. From the submenu, choose Clear.

Note: Hidden information is not copied to the clipboard.
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Customizing the Layout of Your Work Queue and Other Dynamic Tables
Using the eBusiness Center

The eBusiness Center is where you conduct most of you work, from entering 
customer information to generating leads and tracking opportunities. 

For an overview of eBusiness Center layout functionality, see An Overview of the 
eBusiness Center.

Help is available on the following user tasks: 

■ Displaying and entering customers and prospects

■ Using the Overview tab

■ Using the Address tab

■ Using the Person tab

■ Using the Organization tab

■ Using the Relationships tab

■ Using the Accounts tab

■ Using the Leads tab

■ Using the Opportunity tab

■ Using the Quote and Order tab

■ Using the Event tab

■ Using the Collateral tab

■ Using the Task tab
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Displaying and Entering Customers and Prospects
Help is available on the following topics relating to displaying and entering 
customers.

■ Performing complex searches 

■ Displaying a consumer, a contact, or an organization

■ Checking if an organizational contact already exists in the database

■ Checking if a consumer already exists in the database

■ Checking if an organization already exists in the database

■ Viewing all contacts at an organization

■ Entering a new contact for an existing organization

■ Entering a new contact at a new organization

■ Entering a new consumer

■ Entering a new organization

Displaying a Party in the eBusiness Center Header
You must follow slightly different procedures for displaying consumers, 
organizational contacts, or organizations in the eBusiness center header. Select a 
procedure:

■ Displaying consumers

■ Displaying organizational contacts

■ Displaying organizations

Displaying a Consumer in the eBusiness Center Header
Use this procedure to search for and display a consumer in the eBusiness Center 
header.

Prerequisites
The customer or prospect must already exist in the database.
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Displaying an Organization in the eBusiness Center Header
Steps
1. Navigate to the eBusiness Center.

2. From the Party Type drop-down list, select Person.

3. If you wish to find the individual by their email, then use the Email List of 
Values (LOV). 

4. If you wish to find the individual by their name, then use the First or Last name 
LOVs.

5. If you find the individual in the LOV, then click OK and the name and basic 
contact information is entered in the eBusiness Center header automatically. 

6. If too many results appear for you to examine easily, then click Cancel to close 
the LOV window and perform a complex search for the individual using 
multiple search criteria instead.

Displaying an Organization in the eBusiness Center Header
Use this procedure to search for and display an organization in the eBusiness Center 
header.

Prerequisites
The organization must already exist in the database.

Steps
1. Navigate to the eBusiness Center.

2. From the Party Type drop-down list, select Organization.

3. Place your cursor in the Organization field.

4. Enter CTRL+L on your keyboard and use the List of Values (LOV) to search for 
the name of the organization.

5. If you find the organization in the LOV, then click OK and the organization 
information is entered in the eBusiness Center header automatically. 

6. If too many results appear, then click Cancel to close the LOV window and 
perform a complex search for the organization using multiple search criteria 
instead.
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Displaying an Organizational Contact in the eBusiness Center Header
Use this procedure to search for and display an organizational contact in the 
eBusiness Center header.

Prerequisites
The relationship must already exist in the database.

Steps
1. Navigate to the eBusiness Center.

2. From the Party Type drop-down list, select Party Relationship.

3. Use the Organization List of Values (LOV) to enter the organization. 

4. Use the Email, First, or Last name LOV to search for and enter the individual.

Checking if an Organizational Contact Already Exists in the Database
Use this procedure to check for duplicate organizational contacts before you make a 
new entry into the database.

Prerequisites
None

Steps
1. Navigate to the eBusiness Center.

2. From the Party Type drop-down list in the header, select Party Relationship.

3. Search for the contact’s organization using the Organization List of Values 
(LOV).

4. If the organization does not exist in the database, then click Cancel in the LOV 
window and proceed with the new contact entry in the eBusiness Center.

5. If the contact’s organization is listed in the Organization LOV, then:

a. Enter the Organization.

b. Place your cursor in the First or Last Name fields.

c. Select CTRL+L on your keyboard and use the List of Values to search for 
the name.
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Checking if an Organization Already Exists in the Database
d. If a duplicate is not listed in the results of your search, then click Cancel to 
return to the eBusiness center where you can make your new entry.

e. If you find the individual in the search results, then click OK and the name 
is entered in the eBusiness Center automatically. 

f. If too many results appear for you to examine easily, then click Cancel to 
close the LOV window and perform a complex search for the individual 
using multiple search criteria instead.

Checking to See If a Consumer Already Exists in the Database
Use this procedure to check if a consumer you are about to enter exists in the 
database. This prevents duplicate entries into your database.

Prerequisites
None

Steps
1. Navigate to the eBusiness Center.

2. From the Party Type drop-down list, select Person.

3. Use the Email, First name, or Last name fields List of Values (LOV) to search for 
the individual.

4. If you do not find the individual in the LOV, then click Cancel to close the LOV 
window. 

5. If too many results appear for you to examine easily, then click Cancel to close 
the LOV window and perform a complex search for the individual using 
multiple search criteria instead.

Checking if an Organization Already Exists in the Database
Use this procedure to check to see if an organization is already in the database 
before you add it.

Steps
1. Navigate to the eBusiness Center.

2. From the Party Type drop-down list, select Organization.
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Viewing All Contacts at an Organization
3. Place your cursor in the Organization field.

4. Select CTRL+L on your keyboard and use the List of Values to search for the 
organization name.

5. If the organization is not listed in the results of your search, then click Cancel to 
return to the eBusiness center where you can make your new entry.

6. If you find the organization in the search results, then click OK and the name is 
entered in the eBusiness center automatically. 

Viewing All Contacts at an Organization
Use this procedure to view all of the contacts at an organization.

Prerequisites
None

Steps
1. If the eBusiness Center is blank or does not display the correct organization, 

then:

a. From the Party Type drop-down list, select Party Relationship.

b. Use the Organization List of Values (LOV) to select the organization.

c. Use the First or Last field LOV to view the list of contacts at the 
organization. You can search on partial names provided you use the wild 
card % to indicate missing letters.

2. If the eBusiness Center header displays the correct organization and 
Organization is selected from the Party Type drop-down list, then:

a. In the View Details for region, select the button labeled with the name of the 
organization.

b. Select the Relationships tab.

c. The Object Relationship region displays the contacts for the organization.

d. If you wish to view or modify the details of any of the contacts, then select 
one by clicking on the drill-down button to the left of the record you wish 
to view. The drill-down button is the unlabeled blue button all the way to 
the left of the record. 
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Entering a New Contact for an Existing Organization
3. If the eBusiness Center header displays the correct organization and Party 
Relationship is selected from the Party Type drop-down list, then use the First 
or Last LOVs to display the list of contacts at the organization.

Entering a New Contact for an Existing Organization
Use this procedure to enter a new contact at an existing organization. 

Prerequisites
Check to see if the contact already exists at the organization to prevent duplicate 
entries.

Steps
1. Navigate to the eBusiness center.

2. Display the organization in the eBusiness Center header.

3. From the Party Type drop-down list, select Party Relationship.

4. Click Create.

The New Party dialog box appears.

5. Click Person.

6. Enter the individual’s title.

7. Enter the individual’s first and last name. The middle initial is optional.

8. Use the Relation LOV to select the relationship between the contact and the 
organization. 

9. Optionally, enter a primary address, phone number, and email. 

10. If the Organization field is blank or does not display the correct organization, 
use the List of Values (LOV) to enter the individual’s organization.

11. Enter CTRL+S on your keyboard or click Save on the toolbar.

Note: If you wish to send electronic collateral to this individual, 
then you must enter the email address under the party type of 
Person. This is because the collateral tab in this release uses email 
addresses entered for the party type of Person (the consumer) and 
not the Party Relationship (organizational contact).
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Entering a New Contact at a New Organization
You are now ready to perform different tasks in the eBusiness Center tabs, 
including:

■ Entering a billing, shipping and other addresses for the contact. Billing and 
shipping addresses are required if your customer is making a purchase.

■ Entering phone numbers and e-mail addresses.

■ Entering personal details about the contact in the person tab.

Entering a New Contact at a New Organization
Use this procedure to enter a new contact at a new organization

Prerequisites
Check to make sure the contact does not already exist in the database to prevent 
duplicate entries.

Steps
1. Navigate to the eBusiness center.

2. From the Party Type drop-down list, select Party Relationship.

3. Click Create.

The New Party dialog box appears.

4. Click Both.

5. Use the Organization List of Values (LOV) to check if the organization does not 
already exist in the database.

6. Enter the organization name.

7. Select a title for the contact.

8. Enter the contact’s name.

9. If you wish to change the default relationship for the contact, then use the 
Relationship LOV to select a different one.

10. Enter the contact’s primary phone number in four separate fields: the country 
code, the calling area code, the phone number itself, the extension if any.

11. Using the Type drop-down list, select the phone number type.

12. Enter the contact’s email address. 
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Entering a New Contact at a New Organization
13. Enter the contact’s primary address. If you need additional address lines, then 
click the ellipsis button. The address you enter here is the primary address for 
the contact and appears whenever you display the contact in the eBusiness 
Center header. 

14. Click Save on the toolbar.

You are now ready to perform different tasks in the eBusiness Center tabs. You can:

■ Enter details about the contact’s organization

■ Designate different uses for the address you entered. You may want to 
designate the same address as shipping and billing, for instance.

■ Enter other addresses, including billing and shipping, for the organization or 
the contact.

Guidelines
You may wish to enter only the contact name and organization in the eBusiness 
center header and enter other information, including email, phone, and address, in 
the eBusiness Center tabs. Use the header to enter only the primary contact 
information. The tabs below allow you to enter multiple addresses, phone numbers, 
email addresses, and URLs. 

Note 1: The phone number and email you enter here is tied to the 
contact and not the organization.

Note 2: If you wish to send electronic collateral to this individual, 
then you must enter the email address under the party type of 
Person. This is because the collateral tab in this release uses the 
email addresses entered in the party type of person (the consumer) 
and not the party relationship (organizational contact).

Note: By default, the address you enter here for the contact 
automatically becomes an address for the organization as well. 
Your application administrator can disable this feature by resetting 
the profile option OTS: ASSOCIATE RELATIONSHIP LOCATION 
TO ORGANIZATION to no.
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Entering a New Consumer
Entering a New Consumer
Use this procedure to enter a new consumer.

Prerequisites
Check to make sure the consumer does not already exist in the database to prevent 
duplicate entries.

Steps
1. Navigate to the eBusiness center.

2. From the Party Type drop-down list, select Person.

3. Click Create.

4. From the Title drop-down list, select a title for the consumer.

5. Enter the consumer’s name.

6. Enter the consumer’s primary phone number in four separate fields: the 
country code, the calling area code, the phone number itself, the extension if 
any.

7. Using the Type drop-down list, select the phone number type.

8. Enter the consumer’s primary email address. 

9. Enter the contact’s primary mailing address. If you need additional address 
lines, then click the ellipsis button. The address you enter here appears 
whenever this consumer is displayed in the eBusiness Center header. 

10. Click Save on the toolbar.

You are now ready to:

■ Enter details about the consumer

■ Designate different uses for the address you entered. You may want to 
designate the same address as shipping and billing, for instance.

■ Enter other addresses, including billing and shipping, for the consumer. 

Guidelines
You may wish to enter only the consumer name in the eBusiness center header and 
enter other information, including email, phone, and address, in the eBusiness 
Center tabs. Use the header to enter only the primary contact information. The tabs 
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Entering a New Organization
below allow you to enter multiple addresses, phone numbers, email addresses, and 
URLs. 

Entering a New Organization
Use this procedure to create a new organization.

Prerequisites
None

Steps
1. Navigate to the eBusiness Center.

2. From the Party Type drop-down list, select Organization.

3. Use the Organization List of Values (LOV) to check if the organization does not 
already exist in the database.

4. Enter the organization’s name.

5. Enter the organization’s primary phone number in four separate fields: the 
country code, the calling area code, the phone number itself, the extension if 
any.

6. Using the Type drop-down list, select the phone number type.

7. Enter the organization’s primary email address. 
 

8. Enter the organization’s primary address. If you need additional address lines, 
then click the ellipsis button. The address you enter here is the primary address 
for the organization and appears whenever you display the organization as 
party type of organization. 

9. Click Save on the toolbar.

You are now ready to:

■ Enter other phone numbers, email, and URLs for the organization.

■ Enter other details about the organization. 

Note: The phone number and email you enter here is tied to the 
organization and does not appear when you are viewing contacts 
for the organization.
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Using the Overview Tab
Using the Overview Tab
Use the Overview tab of the eBusiness Center to view notes and interactions your 
organization has had with the customer, to enter notes of your own, and to enter the 
campaign the customer is calling about. A campaign is required for sending 
collateral and enrolling contacts.

You can obtain help on the following:

■ Entering the campaign and offer for the call

■ Searching for a campaign when you do not know its name

■ Launching a script for your customer interaction

■ Entering notes

■ Viewing the most recent notes

■ Viewing all notes entered on a customer

■ Searching for text within notes

■ Viewing the most recent interactions

Entering the Campaign and Offer for the Call
Use this procedure to enter the campaign and offer for the call. You must enter a 
campaign before preparing quotes or launching scripts.

Prerequisites
Display the party in the eBusiness Center header and select the appropriate party in 
the View Details for region.

Steps
1. Select the Overview tab.

2. If the caller does not know the campaign name, then click Search Campaign 
and search for the campaign using other criteria such as the campaign code or 
the medium where the campaign is run.

3. If the caller knows the campaign name, then enter it using the Campaign List of 
Values.

4. Optionally, use the Offer LOV to enter the offer.

5. Click Save on the toolbar or press CTRL+S on your keyboard.
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Using the Overview Tab
You are now ready to:

■ Launch a script

■ Create a lead

Searching for a Campaign When You Do Not Know Its Name
Use this procedure to search for a campaign for a customer or prospect using any 
number of search criteria. This includes the campaign code, the dates of a 
campaign, or the medium in which the campaign is run. 

Prerequisites
You must first display the customer or prospect in the eBusiness header and select 
the appropriate party in the View Details For region. 

Steps
1. In the eBusiness Center, select the Overview tab.

2. Click Search Campaign.

The Universal Search window appears.

3. Enter one or more search criteria in the Basic tab.

You can enter partial words if you are not sure of a spelling but you must use 
the wild card % to indicate missing or unknown letters. 

4. Click Search.

The search results display in the Results region below.

5. If the results are not satisfactory, can modify the search criteria and repeat the 
search.

6. Select the campaign from the list of results.

7. Click OK.

The campaign appears in the Overview tab.

Launching a Script for Your Customer Interaction
Use this procedure to launch a script to guide you in your interaction with a 
customer or prospect.
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Using the Overview Tab
Prerequisites
You must display the customer or prospect in the eBusiness header and select the 
appropriate party in the View Details For region. 

Steps
1. In the eBusiness Center, select the Overview tab.

2. If the caller knows the name of the campaign, then enter it using the Campaign 
List of Values.

3. If the caller does not know the campaign name, then click Search Campaign 
and search for the campaign using other criteria, such as the campaign code or 
the medium where the campaign is run.

4. If the View Script button is enabled, click on it to launch the script.

5. If the View Script button is disabled, this means no specific script has been 
associated with this campaign. In this case, you may wish to view a list of all of 
the available scripts:

a.  Click All Scripts.

The Agent Scripts window appears.

b. If an appropriate script is available, then select the script and click View 
Script to launch the script.

c. If no appropriate script is listed, then click Close.

Entering Notes on a Customer
Use this procedure to take notes on a consumer, organization, and a business 
contact. You must remember that the notes you save are linked to the party you 
have chosen using the radio buttons in the View Details For region.

Prerequisites
You must display a party in the eBusiness Center header and select a radio button 
in the View Details For region corresponding to the party you wish to enter notes 
for. 

Steps
1. In the eBusiness Center, select the Overview tab.

2. Enter the note in the New Note text box.
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Using the Overview Tab
3. Click Save on the toolbar.

The note remains editable as long as you do not change parties or exit the 
application. 

4. If you wish to create a second note, then:

a. Place your cursor in the New Note text box.

b. Click New in the toolbar. This is the button with a green plus sign.

c. Enter the note and click Save.

Guidelines
Notes are linked to the entity where you create them. If you wish to enter notes on a 
lead, then enter it in the leads tab. (See Entering Notes on a Lead.) If you wish to 
enter notes on an opportunity, then enter it in the Opportunity tab. (See Entering 
Notes for an Opportunity.)

References
About Notes

Viewing the Most Recent Notes
Use this procedure to view notes on a consumer, organization, or an organizational 
contact.

Prerequisites
You must display the party in the eBusiness Center header and select a radio button 
in the View Details For region corresponding to the party you wish to view notes 
for. 

Steps
1. In the eBusiness Center, select the Overview tab.

2. In the Interaction History region, select Notes from the View drop-down list.

The most recent notes for the contact appear below.

3. If the full text of the note is not visible, then place your cursor over the note text 
to view the full text in a tool-tip window. You can also expand the row by 
dragging the bottom of the selection field on the left.
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4. If you wish to view all of the notes for the party, then click All Notes. See 
Viewing All Notes on a Customer for details. 

References
About Notes

Viewing All Notes on a Customer
Use this procedure to view the notes entered for a consumer, an organization, or an 
organizational contact.

Prerequisites
You must display the party in the eBusiness Center header. 

Steps
1. In the eBusiness Center, select a radio button in the View Details For region 

corresponding to the party you wish to view notes for.

2. From the Tools menu, choose All Notes or click the All Notes button.

The Notes window appears. 

3. Enter the filtering criteria for the notes you wish to see:

a. If you wish to see all of the notes for an organization, its leads, and its 
opportunities, then make sure the check box labeled with the name of the 
organization is selected. Leave the other fields blank.

b. If you wish to view notes for a specific individual, then enter that 
individual in the Person field using the List of Values (LOV). If you are 
viewing notes on a consumer, then this field is prefilled for you.

c. If you wish to view only the leads or opportunities for the organization or 
individual you have selected above, then use the Related To LOV to specify 
which you wish to see.

4. Click Find.

Note: If you are viewing information for the party of Person, then 
the organization check box is disabled.
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The left pane lists all of the notes that meet you search criteria sorted by the 
date they were entered.

5. To see the full text of the note, select the note you wish to view on the left. The 
text is displayed on the right.

6. You can sort notes by clicking on different column headings in the Notes tab 
list. 

7. If you wish to filter the notes displayed in the list by object type, for example, to 
view only notes for opportunities, then:

a. In the Filter By region, use the Related To LOV to enter the object type. 

b. Optionally, select a value using the Value LOV.

c. Click Find. 

References
Searching for Text Within Notes

About Notes

Searching for Text Within Notes
Use this procedure to find text in notes listed in a table.

 Prerequisites
You can only perform this procedure within any table listing notes, such as the 
Notes table in the Overview tab of the eBusiness Center or the listing of notes in the 
Notes window.

Steps
1. Right-click on any cell in the table.

2. Select Find in Table from the pop-up menu.

3. Type the characters wish to search on into the text field. 

4. Indicate whether to match case, and select the direction of the search, backward 
or forward.

5. Click Find.

The application highlights the record containing the first instance of your search 
term. 
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6. You can click Cancel to stop a long running search.

References
About Notes

Viewing the Most Recent Interactions for a Party
Use this procedure to view the most recent interactions your organization has had 
with a consumer, organization, or an organizational contact. Interactions track all 
contacts made in the eBusiness suite of applications between agents of your 
organization and the party.

Prerequisites
You must display the party in the eBusiness Center header. 

Steps
1. In the eBusiness Center, select a radio button in the View Details For region 

corresponding to the party you wish to view interactions for.

2. Select the Overview tab.

3. In the Interaction History region, select Interactions from the View drop-down 
list.

The most recent interactions for the contact appear below.

4. If the full text of the interaction is not visible, then place your cursor over the 
note text to view the full text in a tool-tip window. You can also expand the row 
by dragging the bottom of the selection field on the left.

5. If you wish to view all of interactions for the party, then click All Interactions. 
See Interaction History documentation in Oracle CRM Foundation Concepts and 
Procedures for details. 
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Using the Address Tab
Use the Address tab of the eBusiness Center to enter addresses and specify their 
uses. You can obtain help on the following procedures:

■ Entering an address

■ Entering an address for a contact at an organization

■ Entering an address for an organization

■ Entering an address for a consumer

■ Specifying uses for an address

Entering an Address
Use this procedure to enter an address. 

Prerequisites
The party for which you wish to enter an address must already be in the database.

Steps
1. Enter an address. The procedures for entering addresses for organizations, 

consumers and contacts for an organization are slightly different, so select the 
appropriate party below:

■ Contact at an organization.

■ Consumer

■ Organization

2. Select the uses for the address, such as billing and shipping.

Entering an Address for a Contact at an Organization
Use this procedure to enter an address for a contact at an organization. If you are 
entering a private address, then you must enter it under the party type of person. If 
you are entering a business address, then enter it under the party type of party 
relationship. 

A party can have multiple addresses, but only one primary address. The primary 
address is the one that appears in the eBusiness Center header when you display 
the party.
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Prerequisites
Display the contact at an organization in the eBusiness Center header.

Steps
1. If you are entering a private address then, in the View Details For region, select 

a radio button labeled with the name of the person. This is the first button from 
the left.

2. If you are entering an address tied to the contact’s role in an organization, then, 
in the View Details For region, select a radio button labeled with the name of 
the person and the organization. This is the third button from the left.

3. Select the Address tab.

4. In a blank line, enter the street address in the Address 1 field.

5. If you need additional address lines, then:

a. Click the ellipsis button to the right of the Address 1 field.

b. The Address Information window appears.

c. Enter up to three more address lines. 

d. Click OK.

6. Enter other address information. City, state, postal code, and country are 
required. Province and county are optional fields. 

7. If the address is the primary address for the contact, then select the Primary 
check box. 

Note: This radio button is disabled if the header displays 
information on an organization.

Note: This radio button is disabled if the header displays 
information on either the party type of organization or person.

Note: You can only have one primary address for a contact
56 Oracle TeleSales Concepts and Procedures 



Using the Address Tab
8. Specify the different uses using the Address Usage column. A single address 
can have multiple uses, as the shipping and billing address, for example:

a. Use the Address Usage field LOV to specify a use for this address.

b. To specify additional uses, select a new line and repeat the previous step.

Guidelines

Entering an Address for an Organization
Use this procedure to enter an address for an organization. You can enter an address 
for an organization when the eBusiness Center header displays either a party type 
of organization or party type of party relationship. 

An organization can have multiple addresses, but only one primary address. The 
primary address is the one that appears in the eBusiness Center header when you 
display a party type of organization.

Prerequisites
 Display the party in the eBusiness Center header.

Steps
1. In the View Details For region, select a radio button labeled with the name of 

the organization. This is the second button from the left.

2. Select the Address tab.

Note: By default, an address you enter for a contact at an 
organization (party of type party relationship) automatically 
becomes an address for the organization as well. A primary address 
you enter does not automatically become a primary address for the 
organization as well, however. This feature can be turned off by 
your application administrator by resetting the profile option OTS: 
ASSOCIATE RELATIONSHIP LOCATION TO ORGANIZATION 
to no.

Note: This radio button is disabled if the header displays 
information on a consumer (the party type of person).
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3. In a blank line, enter the street address in the Address 1 field.

4. If you need additional address lines, then:

a. Click the ellipsis button to the right of the Address 1 field.

b. The Address Information window appears.

c. Enter up to three more address lines. 

d. Click OK.

5. Enter other address information. City, state, postal code, and country are 
required. Province and county are optional fields. 

6. If the address is the primary address for the contact, then select the Primary 
check box. 

7. Specify the different uses using the Address Usage column. A single address 
can have multiple uses, as the shipping and billing address, for example:

a. Use the Address Usage field LOV to specify a use for this address.

b. For specify additional uses, select a new line and repeat the previous step.

Entering an Address for a Consumer
Use this procedure to enter an address for a consumer. A consumer can have 
multiple addresses, but only one primary address. The primary address is the one 
that appears in the eBusiness Center header when you display a party type of 
person.

Prerequisites
 Display the party in the eBusiness Center header.

Steps
1. In the View Details For region, select a radio button labeled with the 

individual’s name. This is the first button from the left.

Note: You can only have one primary address for the 
organization.
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2. Select the Address tab.

3. In a blank line, enter the street address in the Address 1 field.

4. If you need additional address lines, then:

a. Click the ellipsis button to the right of the Address 1 field.

b. The Address Information window appears.

c. Enter up to three more address lines. 

d. Click OK.

5. Enter other address information. City, state, postal code, and country are 
required. Province and county are optional fields. 

6. If the address is the primary address for the consumer, then select the Primary 
check box. 

7. Specify the different uses using the Address Usage column. A single address 
can have multiple uses, as the shipping and billing address, for example:

a. Use the Address Usage field LOV to specify a use for this address.

b. For specify additional uses, select a new line and repeat the previous step.

Specifying Multiple Uses for an Address
Use this procedure to specify multiple different uses for an address. For example, 
use this procedure to specify a single address to be the home, the billing, and the 
shipping address.

Prerequisites
 Display the party in the eBusiness Center header and select the appropriate party 
in the View Details for region.

Note: This radio button is disabled if the header displays 
information on an organization (the party type of organization).

Note: You can only have one primary address for a consumer.
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Steps
1. Select the Address tab.

2. Select the address. You can do so by either clicking in any address field or on 
the select button all the way to the left.

3. Place the cursor in a blank Address Type field and use the List of Values specify 
a use for this address.

4. Repeat the last step for any additional uses for this address. A single address 
can have multiple entries in the Address Type column.

5. Click Save on the toolbar.

Guidelines
See About the Address Tab for an example.

Using the Person Tab
Use the Person tab in the eBusiness Center to enter information about a consumer 
or personal details about a contact at an organization. 

You can obtain help on:

■ Entering phone, email, and URLs for a consumer

■ Entering phone, email, and URLs for an organizational contact

■ Entering name pronunciation, language and other details

■ Entering details about a person’s educational background

■ Entering details about a person’s product interest

■ Entering details about a person’s employment and military history

■ Entering details about an individual’s personal interests

■ Specifying a sales team for an individual contact or consumer 

■ Restricting interactions with organizational contacts

■ Restricting interactions with consumers

Note: This tab is disabled if you select the radio button labeled 
with the name of the organization from the View Details For region.
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Entering Phone, Email, and URLs for a Consumer
Use this procedure to enter phone numbers, email addresses, and URLs for an 
individual consumer.

Prerequisites
Display the party in the eBusiness Center header.

Steps
1. In the View Details For region, select a radio button labeled with the person’s 

name. This is the first radio button from the left.

2. Select the Person tab.

3. From the Display drop-down list, select Contact Points.

4. Use the Contact Method LOV select the information type that you wish to enter.

5. If you are entering a phone number, then:

a. Use the Type LOV to select the phone type.

b. Enter the phone number in the three Value fields: international code, area 
code, phone number. Be sure to use a standard format for your entries. 
Searches on phone numbers are sensitive to punctuation such as dashes or 
spaces.

c. Enter an extension if any.

d. Optionally, suggest a time this number can used by making entries in the 
Best Time From and Best Time To fields.

e. If this phone number is the primary phone number which is to appear in 
the eBusiness Center header, then select the Primary check box.

6. If you are entering an email address, then:

a. Enter the email in the last of the three Value fields.

Note: This radio button is disabled if the header displays 
information on an organization.

Note: A consumer can have only one primary phone number.
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b. If this email is the primary email which is to appear in the eBusiness Center 
header, then select the Primary check box.

7. If you are entering a URL, then:

a. Enter the URL in the last of the three Value fields.

b. If this URL is the primary email which is to appear in the eBusiness Center 
header, then select the Primary check box. 

8. Click Save on the toolbar.

Entering Phone, Email, and URLs for an Organizational Contact
Use this procedure to enter phone numbers, email addresses, and URLs for a 
contact at an organization. 

Prerequisites
Display the organizational contact in the eBusiness Center header.

Steps
1. In the View Details For region, select a radio button labeled with the name of 

the person and the organization. This is the third button from the left.

2. Select the Person tab.

Note: A consumer can have only one primary email address.

Note: A consumer can have only one primary URL.

Note: The information you enter remains tied to this contact. It is 
not be visible when you view information about the individual as a 
consumer or if you view information about the contact’s 
organization.

Note: This radio button is disabled if the header displays 
information on either the party type of organization or person.
62 Oracle TeleSales Concepts and Procedures 



Using the Person Tab
3. From the Display drop-down list, select Contact Points.

4. Use the Contact Method LOV to select the information type that you wish to 
enter.

5. If you are entering a phone number, then: 

a. Select phone from the Contact Method LOV. 

b. Use the Type LOV to select the phone type.

c. Enter the phone number in the three Value fields: international code, area 
code, phone number. Be sure to use a standard format for your entries. 
Searches on phone numbers are sensitive to punctuation such as dashes or 
spaces.

d. Enter an extension if any.

e. Optionally, suggest a time this number can used by making entries in the 
Best Time From and Best Time To fields.

f. If this phone number is the primary phone number which is to appear in 
the eBusiness Center header, then select the Primary check box.

6. If you are entering an email address, then:

a. Select email from the Contact Method LOV.

b. Enter the email in the last of the three Value fields.

c. If this email is the primary email which is to appear in the eBusiness Center 
header, then select the Primary check box.

7. If you are entering a URL, then:

a. Select web from the Contact Method LOV.

b. Enter the URL in the last of the three Value fields.

c. If this URL is the primary email which is to appear in the eBusiness Center 
header, then select the Primary check box. 

Note: A contact can have only one primary phone number.

Note: A contact can have only one primary email address.
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8. Click Save on the toolbar.

Using the Person Details Window
You can obtain help on the following procedures in this window:

■ Entering details about a person’s educational background

■ Entering details about a person’s product interest

■ Entering details about a person’s employment and military history

■ Entering details about a person’s personal interests

■ Specifying a sales team for a consumer 

Entering Details About a Person’s Educational Background
Use this procedure to enter details about the educational background of a consumer 
or organizational contact. The information you enter here is stored with the party of 
type person.

Prerequisites
Display the consumer or the organizational contact in the eBusiness Center header.

Steps
1. In the View Details For region, select a radio button labeled with the 

individual’s name. This is the first button from the left.

2. Select Person tab.

3. Click Details.

The Person Details window appears.

4. Select the Education tab.

Note: A contact can have only one primary URL.

Note: This radio button is disabled if the header displays 
information on an organization (the party type of organization).
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5. You can enter multiple schools and courses of study. For each entry:

a. Place your cursor in the School field.

b. Click New.

c. Enter the school name and other details about the individual’s education in 
the fields provided.

d. Click Save on the toolbar.

6. When you are done, select another tab or click Cancel to close the Person 
Details window. 

Entering Details About a Person’s Product Interest
Use this procedure to enter details about the product interests for a consumer or an 
organizational contact. The information you enter here is stored with the party of 
type person.

Prerequisites
Display the consumer or the organizational contact in the eBusiness Center header.

Steps
1. In the View Details For region, select a radio button labeled with the 

individual’s name. This is the first button from the left.

2. Select Person tab.

3. Click Details.

The Person Details window appears.

4. Select the Product Interest tab.

Note: The list is not refreshed automatically, so your entry does 
not appear in the list until the next time you select this tab or open 
this window.

Note: This radio button is disabled if the header displays 
information on an organization (the party type of organization).
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5. You can enter multiple product interests. For each entry:

a. Place your cursor in the Type, Primary, or Secondary fields.

b. Click New.

c. Enter the product interest using the List of Values provided.

d. Click Save on the toolbar.

6. When you are done, select another tab or click Cancel to close the Person 
Details window. 

Entering Details About a Person’s Employment and Military History
Use this procedure to enter details about the person’s employment and military 
service history for a consumer or an organizational contact. The information you 
enter here is stored with the party of type person.

Prerequisites
Display the consumer or the organizational contact in the eBusiness Center header.

Steps
1. In the View Details For region, select a radio button labeled with the 

individual’s name. This is the first button from the left.

2. Select Person tab.

3. Click Details.

The Person Details window appears.

4. Select the Job/Military History tab.

5. You can enter multiple jobs or positions. For each entry:

Note: The list is not refreshed automatically, so your entry does 
not appear in the list until the next time you select this tab or open 
this window.

Note: This radio button is disabled if the header displays 
information on an organization (the party type of organization).
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a. Place your cursor in any of the entry fields in the bottom half of the tab.

b. Click New.

c. Enter the job or military history in the fields provided. 

d. Click Save on the toolbar.

6. When you are done, select another tab or click Cancel to close the Person 
Details window. 

Entering Details About an Individual’s Personal Interests
Use this procedure to enter details about an individual’s personal interests. The 
information you enter here is stored with the party of type person.

Prerequisites
Display the consumer or the organizational contact in the eBusiness Center header.

Steps
1. In the View Details For region, select a radio button labeled with the 

individual’s name. This is the first button from the left.

2. Select Person tab.

3. Click Details.

The Person Details window appears.

4. Select the Personal Interest tab.

5. You can enter multiple interests. For each entry:

a. Place your cursor in any of the entry fields in the bottom half of the tab.

Note: The list is not refreshed automatically, so your entry does 
not appear in the list until the next time you select this tab or open 
this window.

Note: This radio button is disabled if the header displays 
information on an organization (the party type of organization).
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b. Click New.

c. Enter the interests using the fields provided. 

d. Click Save on the toolbar.

6. When you are done, select another tab or click Cancel to close the Person 
Details window. 

Specifying a Sales Team for a Consumer 
Use this procedure to select sales team members for a consumer. In most 
implementations, sales team members are assigned automatically to an organization 
by the CRM Territory Management module. However, you can use this procedure 
to over-ride this assignment or assign additional team members of your own.

Prerequisites
You must display the consumer or a contact at an organization in the eBusiness 
Center header.

Steps
1. In the View Details For region of the eBusiness Center, select the radio button 

labeled with the individual’s name. This is the first button from the left.

2. Select the Person tab.

3. Click Details.

The Person Details window appears.

4. Select the Sales Team tab.

5. You can add multiple sales team members and partners to the sales team. For 
each member:

Note: The list is not refreshed automatically, so your entry does 
not appear in the list until the next time you select this tab or open 
this window.

Note: This radio button is disabled if the header displays 
information on a organization (the party type of organization).
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a. If you wish to select a partner for the sales team, then, from the Display 
drop-down list, select Partner. The selection is Employee by default.

b. Place your cursor in the Name field. It does not matter if this field is blank 
or displays a name.

c. Click New.

d. Use the Name List of Values (LOV) to select a sales team member.

e. If you wish this individual to have view-only access to all opportunities and 
leads for this customer regardless of whether they are on the sales team for 
that opportunity or are assigned a lead, then use the Role LOVs to assign 
the role of Account Manager. 

f. If you wish to keep the new team member on the team regardless of the 
assignment made by the territory management module, then select the 
Freeze check box.

g. Click Save on the toolbar.

6. When you are done, select another tab or click Cancel to close the Person 
Details window. 

Entering Name Pronunciation, Language, and Other Personal Details
Use this procedure to enter the pronunciation of a person’s name and other 
personal information for a consumer and organizational contact. You can enter a 
division and manager information for an organizational contact, but not for a 
consumer. All fields are optional.

Note: The role you assign here is different from the group and role 
you select for reporting purposes.

Note: The Team Leader check box is no longer used in this release. 

Note: The list of team members is not refreshed automatically, so 
your entry does not appear in the list until the next time you select 
this tab or open this window.
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Prerequisites
Display the organizational contact in the eBusiness Center header.

Steps
1. In the View Details For region, select a radio button labeled with the name of 

the person and the organization. This is the third button from the left.

2. Select the Person tab.

3. Make entries in the fields provided. If you are entering a consumer, then the 
organization-related fields are disabled.

4. Click Save in the toolbar.

5. If you wish to add details such as the contact’s interests and educational history 
or modify the sales team assigned to this contact, then click Details and follow 
one of the procedures below:

■ Entering details about a person’s educational background

■ Entering details about a person’s product interest

■ Entering details about a person’s employment and military history

■ Entering details about a person’s personal interests

■ Specifying a sales team for an individual contact or consumer 

Guidelines
The table below gives guidelines for entry in some of the available fields:

Note: This radio button is disabled if the header displays 
information on either the party type of organization or person.

Field/Box Explanation

Alias A free-text field where you can enter any other 
names this individual is known by.

Suffix A free-text field for honorific titles.

Native Language List of Values (LOV).
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Restricting Interactions with Organizational Contacts
Use this procedure to restrict your organization’s interactions via email or phone 
with organizational contacts. You may want to use this procedure if a contact is 
away on vacation, for example, or does not want to be contacted by telephone.

Prerequisites
Display the organizational contact in the eBusiness Center header.

Steps
1. In the View Details For region, select a radio button labeled with the name of 

the person and the organization. This is the third button from the left.

2. Select the Person tab.

3. From the Display drop-down list, select Restrictions.

4. Enter one or more restrictions on your company’s interaction with the contact:

a. Use the Restriction List of Values (LOV) to specify the type of contact you 
wish to restrict.

b. Enter a period for the restriction. If you do not enter an end date, then the 
restriction remains in effect indefinitely.

c. Use the Reason LOV to enter a reason.

5. Click Save on the toolbar to save your work.

Job Title A free-text field for the individual’s job title. 
Because job titles vary, you may wish to classify 
the job title using the Job Title Type LOV

Job Title Type List of Values you can use to classify the job title 
you entered.

Department Free-text field for entering the actual department 
name.

Department Type Classification of the department name.

Note: This radio button is disabled if the header displays 
information on either the party type of organization or person.

Field/Box Explanation
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Restricting Interactions with consumers
Use this procedure to restrict your organization’s interactions with consumers. You 
will want to use this procedure to indicate a person is away on vacation, for 
example, or does not want to be phoned at dinner time.

Prerequisites
Display the consumer in the eBusiness Center header.

Steps
1. In the View Details For region, select a radio button labeled with the person’s 

name. This is the first button from the left.

2. Select the Person tab.

3. From the Display drop-down list, select Restrictions.

4. Enter one or more restrictions on your company’s interaction with the 
individual:

a. Use the Restriction List of Values (LOV) to specify the type of contact you 
wish to restrict.

b. Enter a period for the restriction. If you do not enter an end date, then the 
restriction remains in effect indefinitely.

c. Use the Reason LOV to enter a reason.

5. Click Save on the toolbar to save your work.

Note: This radio button is disabled if the header displays 
information on a party type of organization.
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Using the Organization Tab
Use the Organization tab of the eBusiness Center to enter details about an 
organization. 

You can obtain help on:

■ Entering phone, email, and URL information for an organization

■ Entering revenue, fiscal year, and other organization details

■ Viewing an organization’s products under service contracts

■ Classifying an organization by purchase interests

■ Selecting sales team members for an organization

Entering Phone, Email, and URL Information for an Organization
Use this procedure to enter phone numbers, email addresses, and URLs for an 
organization.

Prerequisites
Display the party in the eBusiness Center header.

Steps
1. In the View Details For region, select the radio button labeled with the name of 

the organization. 

2. Select the Organization tab.

3. In a the Contact Points region, use the Contact Method LOV select the 
information type that you wish to enter.

4. If you are entering a phone number, then:

a. Use the Type LOV to select the phone type.

Note: This tab is disabled if you select the radio button labeled 
with the name of the person in the View Details For region.

Note: This radio button is disabled if the header displays 
information on a party type of Person.
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b. Enter the phone number in the three Value fields: international code, area 
code, phone number. Be sure to use a standard format for your entries. 
Searches on phone numbers are sensitive to punctuation such as dashes or 
spaces.

c. Enter an extension if any.

d. Optionally, suggest a time this number can used by making entries in the 
Best Time From and Best Time To fields.

e. If this phone number is the primary phone number which is to appear in 
the eBusiness Center header, then select the Primary check box.

5. If you are entering an email address, then:

a. Enter the email in the last of the three Value fields.

b. If this email is the primary email which is to appear in the eBusiness Center 
header, then select the Primary check box.

6. If you are entering a URL, then:

a. Enter the URL in the last of the three Value fields.

b. If this URL is the primary email which is to appear in the eBusiness Center 
header, then select the Primary check box. 

7. Click Save on the toolbar.

Entering Revenue, Fiscal Year, and Other Organization Details 
Use this procedure to enter information about an organization. This includes, 
purchase interests and information on the fiscal year and revenue.

Note: An organization can have only one primary phone number.

Note: An organization can have only one primary email address.

Note: An organization can have only one primary URL.
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Prerequisites
You must display either the organization or a contact at the organization in the 
eBusiness Center header.

Steps
1. In the View Details For region, select a radio button labeled with the name of 

the organization. This is the second button from the left.

2. Select the Organization tab.

3. In the Organization Focus region, enter information about the company. See the 
Guidelines section below for information on specific fields.

4. Click Save on the toolbar.

5. If you wish to enter a sales team for the organization or classify the organization 
according to product interest, then click Details and follow the procedures for:

■ Classifying an organization by purchase interests

■ Selecting sales team members for an organization

Guidelines
The table below explains some of the available fields in the Organization Focus 
region.

Note: This radio button is disabled if the header displays 
information on a consumer (the party type of person).

Field/Box Explanation

Alias A free-text field where you can enter any other 
names this organization is known by.

Business Line A free-text field for classifying the organization’s 
line of business.

Customer Category List of Values used to categorize the organization. 
This is specified by your implementation team.

Tax ID Tax identification for the organization.

DUNS Number Nine-digit Dun & Bradstreet number for the 
organization
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Using the Organization Details Window
You can obtain help on the following topics: 

■ Viewing an organization’s products under service contracts

■ Classifying an organization by purchase interests

■ Selecting sales team members for an organization

Viewing an Organization’s Products Under Service Contracts
Use this procedure to view the installed base of products under service contracts at 
an organization.

Prerequisites
You must display either the organization or a contact at the organization in the 
eBusiness Center header.

Steps
1. In the View Details For region of the eBusiness Center region, select the radio 

button labeled with the name of the organization. This is the second button 
from the left.

Projected Revenue Projected revenue for the organization

Rating This is a read-only field

Internal radio button Indicates the organization is an internal customer.

External radio button Indicates the organization is an external customer.

Inactive This check box must be unselected. Select this 
check box only to indicate the organization is no 
longer a customer or prospect

Prospect This read-only check box is selected only if the 
organization has made a purchase.

Note: This radio button is disabled if the header displays 
information on a consumer (the party type of person).

Field/Box Explanation
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2. Select the Organization tab.

3. Click Details.

The Organization Details window appears.

4. Select the Install Base tab to view the products under a service contract.

Classifying an Organization by Purchase Interests
Use this procedure to classify an organization according to purchase interest 
categories. Purchase interest categories are broken up into interest types, primary 
interests, and secondary interests.

Prerequisites
You must display either the organization or a contact at the organization in the 
eBusiness Center header.

Steps
1. In the View Details For region of the eBusiness Center, select a radio button 

labeled with the name of the organization. This is the second button from the 
left.

2. Select the Organization tab.

3. Click Details.

The Organization Details window appears.

4. Select the Classification tab.

5. Use the Interest Type, Primary Interest, and Secondary Interest List of Values 
(LOV) to classify the organization’s interest in your products.

6. Optionally, use the Address 1 LOV to enter an address for the site with those 
purchase interests.

7. Click New to save your work.

Note: This radio button is disabled if the header displays 
information on a consumer (the party type of person).
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Selecting Sales Team Members for an Organization
Use this procedure to select sales team members for an organization. In most 
implementations, sales team members are assigned automatically to an organization 
by the CRM Territory Assignment module. However, you can use this procedure to 
over-ride this assignment or assign additional team members of your own.

Prerequisites
You must display either the organization or a contact at the organization in the 
eBusiness Center header.

Steps
1. In the View Details For region of the eBusiness Center, select a radio button 

labeled with the name of the organization. This is the second button from the 
left.

2. Select the Organization tab.

3. Click Details.

The Organization Details window appears.

4. Select the Sales Team tab.

5. You can add multiple sales team members and partners to the sales team. For 
each member:

a. If you wish to select a partner for the sales team, then, from the Display 
drop-down list, select Partner. The selection is Employee by default.

b. Place your cursor in the Name field. It does not matter if this field is blank 
or displays a name.

c. Click New.

d. Use the Name List of Values (LOV) to select a sales team member.

e. If you wish this individual to have view-only access to all opportunities and 
leads for this customer regardless of whether they are on the sales team for 
that opportunity or are assigned a lead, then use the Role LOVs to assign 
the role of Account Manager. 

Note: This radio button is disabled if the header displays 
information on a consumer (the party type of person).
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f. If you wish to keep the new team member on the team regardless of the 
assignment made by the territory management module, then select the 
Freeze check box.

g. Click Save on the toolbar.

Using the Relationships Tab
Use the Relationships tab of the eBusiness Center to capture the relationships 
between individuals and organizations. 

You can obtain help on:

■ Capturing a relationship between a person and an organization

■ Capturing a relationship between two organizations

■ Capturing a relationship between two people

■ Ending a relationship between a person and an organization

Capturing a Relationship Between a Person and an Organization
Use this procedure to capture the relationship between a contact and an 
organization, for example, when a contact moves from one organization to another. 
A contact can have relationships with many organizations. 

Prerequisites
You must display a consumer or display a contact at an organization in the 
eBusiness Center header.

Note: The role you assign here is different from the group and role 
you select for reporting purposes.

Note: The Team Leader check box is no longer used in this release. 

Note: The list is not refreshed automatically, so your entry does 
not appear in the list until the next time you select this tab or open 
this window.
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Steps
1. In the View Details For region, select a radio button labeled with the person’s 

name. This is the first button from the left.

2. Select the Relationships tab.

3. Click in the Subject Name field. It prefills automatically with the name of the 
person.

4. From the Type drop-down list, select the relationship of the person to the 
organization.

5. From the Object Type drop-down list, select Organization.

6. Use the Object Name List of Values to enter the organization.

7. Enter a start date if different from the date of entry.

8. If there is a time limit to the relationship, then enter an end date.

9. Click Save on the toolbar.

References
 Understanding Relationships

Capturing a Relationship Between Two Organizations
Use this procedure to establish and create a relationship between two organizations. 
For example, to capture the fact that one company has been acquired by another.

Prerequisites
You must display one of the organizations or display a contact at one of the 
organizations in the eBusiness Center header.

Steps
1.  In the View Details For region, select the radio button labeled with the name of 

one of the two organizations.

2. Select the Relationships tab.

Note: This radio button is disabled if the header displays 
information on a party type of organization.
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3. In the Subject Relationship region, click in the Subject Name field. It prefills 
automatically with the name of the organization.

4. From the Type drop-down list, select the relationship of the organization to the 
second organization.

5. From the Object Type drop-down list, select Organization.

6. Use the Object Name List of Values to enter the second organization.

7. Enter a start date if different from the date of entry.

8. If there is a time limit to the relationship, then enter an end date.

9. Click Save on the toolbar.

10. Optionally in the Object Relationship region, enter a relationship that is 
symmetrical to the one you entered as a subject region:

a. Use the Subject Type LOV to enter Organization.

b. Use the Subject Name LOV to enter the organization’s name.

c. From the Type drop-down list, select the relationship.

d. The Object Name is already prefilled with the organization name.

e. Enter a start date if different from the date of entry.

f. If there is a time limit to the relationship, then enter an end date.

g. Click Save on the toolbar.

Guidelines
Depending on your business practice, you may wish to capture both sides of a 
relationship. For example, if you entered that organization A is the owner of 
organization B, then you may want to capture the fact that organization B is the 
subsidiary of A.

References
 Understanding Relationships

Capturing a Relationship Between Two People
Use this procedure to capture a relationship between two people, for example, to 
capture the fact two people are married or that one is the boss of another.
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Prerequisites
You must display one of the consumers or display one of the two organizational 
contacts in the eBusiness Center header.

Steps
1.  In the View Details For region, select the radio button labeled with the name of 

the person. This is the first radio button from the left.

2. Select the Relationships tab.

3. In the Subject Relationship region, click in the Subject Name field. It prefills 
automatically with the person’s name.

4. From the Type drop-down list, select the relationship that person has to the 
second person. For example, "Is the manager of", "Is the spouse of" or "is the 
father of".

5. From the Object Type drop-down list, select Person.

6. Use the Object Name List of Values to enter the second person.

7. Enter a start date if different from the date of entry.

8. If there is a time limit to the relationship, then enter an end date.

9. Click Save on the toolbar.

10. Optionally in the Object Relationship region, enter a relationship that is 
symmetrical to the one you entered as a subject region. For example, if you had 
entered: "is the manager of" for the subject relationship, then you will want to 
enter "reports to" for the object relationship. 

a. Use the Subject Type LOV to enter Person.

b. Use the Subject Name LOV to enter the second person’s name.

c. From the Type drop-down list, select the relationship.

d. The Object Name is already prefilled with the name of the person whose 
record you are changing.

e. Enter a start date if different from the date of entry.

f. If there is a time limit to the relationship, then enter an end date.

g. Click Save on the toolbar.
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Guidelines
Depending on your business practice, you may wish to capture both sides of a 
relationship. For example, if you entered that person A is the manager of person B, 
then you may want to capture the fact that person B reports to person A.

Ending a Relationship Between a Person and an Organization
Use this procedure to indicate a person is no longer associated with an organization, 
when the person moves to a job at another organization, for example.

 Prerequisites
You must display the contact in the eBusiness Center header.

Steps
1. In the View Details For region, select a radio button labeled with the name of 

the organization. This is the second button from the left.

2. Select the Relationships tab.

3. In the Subject Relationship region, locate the relationship you wish to terminate.

4. If you are not sure the relationship is permanently ended, then select the 
Inactive check list.

5. If you know the relationship has ended permanently, then enter a date in the 
End Date field. 

6. In the Object Relationship region, repeat the previous two steps for any 
relationships that are related to the relationships you have ended.

7. Click Save on the toolbar.

Note: This radio button is disabled if the header displays 
information on a consumer.
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Using the Accounts Tab
Use the Accounts tab to view information about a customer’s accounts. 

You can obtain help on:

■ Viewing accounts a customer has with your organization

Viewing Accounts a Customer Has with Your Organization
Use this procedure to view information about accounts your customer has with 
your organization. 

This information comes directly from Oracle Receivables. See Oracle Receivables 
documentation for an understanding of the terms and fields in this tab.

Prerequisites
Display the party in the eBusiness Center header.

Steps
1. If you wish to view the accounts of a consumer, then, in the View Details For 

region, select the radio button labeled with the person’s name. This is the first 
button from the left.

2. If you wish to view accounts for an organization, then select the radio button 
labeled with the name of the organization. This is the second button from the 
left.

3. Select the Accounts tab.

The tab displays the accounts in a dynamic table.

4. If you wish to view the details of an account, then:

a. Select the account in the table.

b. Click Details.

The Customer Account Details window appears showing the various aspects of 
the account.

 

Note: In this release, the information in this window is for 
viewing only. Do not attempt to create new accounts.
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Using the Leads Tab
Use the Leads tab in the eBusiness Center to manage your leads. 

You can obtain help on the following:

■ Displaying a lead in the Leads tab

■ Creating a lead

■ Displaying the details of a lead in the Lead Center

■ Entering purchase interests and other details for a lead

■ Viewing opportunities created from a lead

■ Qualifying a lead

■ Turning a lead into an opportunity

■ Checking for duplicates when creating an opportunity from a lead

■ Entering notes on a lead

■ Viewing lead notes

■ Accepting a lead assigned to you

■ Refusing a lead assigned to you

■ Assigning a lead to someone else

Displaying a Lead in the eBusiness Center
Use this procedure to display a lead for an organization or a consumer.

Prerequisites
Display the party in the eBusiness Center header.

Note: This tab is disabled if, in the View Details For region, you 
choose the radio button labeled with the name of the contact and 
organization (the third button from the left). This is because leads 
only apply to consumers and organizations.
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Steps
1. If you wish to view leads for a consumer, then, in the View Details For region, 

select the radio button labeled with the person’s name. This is the first button 
from the left.

2. If you wish to view leads for an organization, then select the radio button 
labeled with the name of the organization. This is the second button from the 
left.

3. Select the Leads tab.

The leads that have been created for this person or organization, if any, are 
listed in the left side of the tab.

4. If you wish to view only open leads, then deselect the Display All radio button.

5. Select the lead you wish to view or modify from the list. The basic information 
about the lead appears on the right side of the tab. 

6. If you wish to view more details about a lead, then click Details to launch the 
Lead Center.

Guidelines
If the lead you wish to work on appears in your work queue, then you can 
double-click on it to display it in the Lead Center where you can modify it. For 
more information about your Work Queue see Accessing Leads, Opportunities, and 
Other Work from Your Work Queue.

Creating a Lead
Use this procedure to create a lead for an organization or a consumer.

Prerequisites
Display the party in the eBusiness Center header.

Steps
1. If you are creating a lead for a consumer, then in the View Details For region, 

select the radio button labeled with the name of the consumer.

2. If you are creating a lead for an organization, then in the View Details For 
region, select the radio button labeled with the name of the organization.
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3. Select the Leads tab.

4. Click New.

5. Enter a name of the project. The name you enter in this free-text field is also 
used as the name for an opportunity you create from this lead. 

6. Optionally, enter a description.

7. If you wish to leave the territory management program to automatically assign 
the lead to a member of the sales team, then leave the Assign to field blank. 
Make an entry only if you wish to over-ride the territory assignment program 
and assign this lead to an agent manually.

8. The status of the lead is new by default. You can choose to override the default 
designation by selecting a status of your own.

The application changes the status to qualified automatically if you enter 
information in a set of fields determined by your implementation team. These 
include project name, time frame, and budget. To qualify a lead, the application 
looks to see only if an entry has been made in specified fields, it does not 
evaluate the quality of the lead. The automatic lead qualification takes place 
after you save the lead.

9. A close reason is required only if you change the status of a lead to closed or 
abandoned.

10. Use the Lead Rank field to evaluate the desirability of the lead. If you leave the 
Lead Rank field blank, then the application ranks the lead based on the 
information you have entered. The ranking takes place after you save the lead.

The application ranks the lead using a lead score card set up by your 
application administrator. For example, a time frame of 1-3 months receives 

Note: You cannot create leads for organizational contacts. 
However, if the eBusiness center header displays a contact, then 
that contact will automatically be listed as the primary contact for 
the lead when you create the lead for the organization. 

Note: A lead must have the status of qualified for it to be turned 
into an opportunity.
Using the eBusiness Center 87



Using the Leads Tab
more points than a time frame of 1 year. A budget of $1 million receives more 
points than a budget of $10,000.

11. Specify the sales channel. By default, this can be either direct or indirect.

12. If you entered the campaign for the customer in the Overview tab, then the 
Campaign Code is prefilled. If you did not make the entry, then enter it now 
using the List of Values (LOV). If you do not know the campaign name, then 
save your work and search for the campaign using other criteria. 

13. If you entered the offer in the Overview tab, then the Offer Code is prefilled. If 
you did not make the entry, then enter the offer now using the LOV.

14. Use the Time Frame LOV to enter a time frame in which you expect the lead to 
close.

15. Enter the budget status.

16. Enter an approximate budget for the lead.

17. If an organization has many locations, then enter a location for the lead.

18. Click Save on the toolbar.

19. Click Details and enter product interest and other details.

Using the Lead Center
You can obtain help on the following:

■ Displaying the details of a lead in the Lead Center

■ Entering purchase interests and other details for a lead

■ Viewing opportunities created from a lead

■ Qualifying a lead

■ Turning a lead into an opportunity

■ Checking for duplicates when creating an opportunity from a lead

■ Entering notes on a lead

■ Viewing lead notes

■ Accepting a lead assigned to you

■ Refusing a lead assigned to you

■ Assigning a lead to someone else
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Displaying the Details of a Lead in the Lead Center
Use this procedure to display the details of a lead in the Lead Center.

Prerequisites
Navigate to the eBusiness Center.

Steps
1.  Display the lead in the Leads tab.

2. Click Details.

The Lead Center window appears displaying the lead details.

Entering Purchase Interests and Other Details for a Lead
Use this procedure to enter a prospect’s purchase interests and other details into an 
existing lead.

Prerequisites
You must create the lead and display it in the Leads tab of the eBusiness Center 
before entering details.

Steps
1. In the Leads tab of the eBusiness Center, click Details.

The Lead Center window appears.

2. In the Purchase Interest tab, use the Lists of Values (LOVs) to enter the 
customer’s product interest using interest categories set up by the application 
implementation team.

3. In the Contact tab, enter the contacts for the lead using the First Name LOV. The 
contacts must already be entered in the database before you can add them here.

4. You can designate one contact as the primary contact by selecting the primary 
check box.

Note:  If you are creating the lead for a contact at an organization, 
then that contact is automatically made the primary contact for the 
lead.
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5. If you wish to assign tasks to others in your organization for this lead, then 
select the Task tab and follow the instructions for creating tasks.

Viewing Opportunities Created from a Lead
Use this procedure to view opportunities that have been created from a lead.

Prerequisites
 Display the lead in the Leads tab of the eBusiness Center before entering details in 
the Lead Center.

Steps
1. In the Leads tab of the eBusiness Center, click Details.

The Lead Center window appears.

2. Select the Opportunity tab.

Any opportunities created from the lead are listed.

3. If you wish to view an opportunity, then select the opportunity from the list and 
click Opportunity Center.

The Opportunity Center displays the details of the opportunity.

Qualifying a Lead
Use this procedure to qualify a lead. A lead must be qualified before it can be 
turned into an opportunity.

Prerequisites
Display the lead you wish to qualify in the Leads tab.

Steps
1. If you wish to let the application qualify the lead automatically, then enter 

information in the required fields. 

The application changes the status of a lead to qualified automatically if you 
enter information in a set of fields specified by the application administrator. 
These include project name, time frame, and budget. To qualify a lead, the 
application looks to see only if an entry has been made in specified fields. It 
does not evaluate the quality of the lead. 
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The application checks to see if the lead is qualified each time you save changes 
to the lead.

2. If you wish to qualify a lead manually, then select Qualified from the Status List 
of Values.

3. Click Save on the toolbar. 

Turning a Lead into an Opportunity
Use this procedure to turn a lead into an opportunity.

Prerequisites
Display the lead in the lead center.

The lead must be qualified before you can turn it into an opportunity.

Steps
1. If the lead does not have a description, enter it now. A description is required 

for opportunity creation.

2. Click Create Oppty.

3. The application checks the lead information you have entered in the lead 
against information in all existing opportunities to see if a similar opportunity 
already exists. 

4. If a potentially duplicate opportunity exists, then the Lead Linking window 
appears. Check for duplicate opportunities to see if you must create a new 
opportunity or simply link any items to an existing one.

Checking for Duplicates When Creating Opportunity from a Lead
Use this procedure to check for duplicate opportunities when you are creating an 
opportunity from a lead and the Lead Linking window appears. 

If you find a duplicate, then you can copy any new items the customer is interested 
in purchasing into an existing opportunity rather than creating a new one. This 
window appears automatically when the application determines potential 
duplicates exists. If this window does not appear, you cannot perform a duplicate 
check. 
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 Prerequisites
You can only check for duplicate opportunities if the Lead Linking window appears 
when you are creating an opportunity from a lead.

Steps
1. The left pane displays the current lead. The right pane displays information on 

possible duplicate opportunities.

2. In the Opportunity Information, select the first opportunity listed.

3. Click Detail.

4. The details of the opportunity you selected displays in the right pane.

5. If the opportunity does not match the lead and more than one potential match 
was found, then scroll through the possible matches using the Next button. The 
number of potential matches is displayed in the Matches Found field. 

6. If the lead on the left matches an opportunity on the right, then:

a. Move any new purchase items from the lead into the opportunity using the 
right arrow key in the middle of the window.

b. Click Link.

7. If none of the opportunities found match, then click Create Oppty to create a 
new opportunity. 

Guidelines
Your application administrator sets the criteria that are used to check for potential 
duplicate opportunities. See Administering Leads.

Entering Notes for a Lead
Use this procedure to enter a note on a lead.

Prerequisites
Display the lead in the Leads tab.

Note: Agents can create links to opportunities even when they do 
not have access to those opportunities.
92 Oracle TeleSales Concepts and Procedures 



Using the Leads Tab
Steps
1. Click Details. 

The Lead Center appears.

2. Place your cursor in the New Note field at the top right-hand side of the 
window.

3. Type a note.

4. Click Save on the toolbar.

5. If you wish to add a second note, then:

a. Place your cursor in the New Note text box.

b. Click New in the toolbar. This is the button with a green plus sign.

c. Enter the note and click Save.

References
About Notes

Viewing Lead Notes
Use this procedure to view all notes entered for a lead.

Prerequisites
None

Steps
1. Display the lead in the Leads tab or in the Lead Center.

2. Click All Notes.

The Notes window appears. The left pane lists all lead notes.

3. To see the full text of the note, select the note you wish to view on the left. The 
text is displayed on the right.

Note: You can edit the note you have entered until you select a 
different party or start entering a new record.
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4. You can sort notes by clicking on different column headings in the Notes tab 
list. 

References
Searching for Text Within Notes

About Notes

Accepting a Lead Assigned to You
Saving a change in a lead assigned to you or creating a new lead automatically 
makes the lead yours.

Refusing a Lead Assigned to You
Use this procedure to refuse a lead that has been assigned to you in error.

Prerequisites
Display the lead you wish to refuse in the Leads tab.

Steps
1. Click Details.

The Lead Center window appears.

2. Click Decline Lead.

The Decline Reason window appears.

3. Use the Decline Reason List of Values to select the reason.

4. Click OK.

Assigning a Lead to Someone Else
Use this procedure to refuse a lead that has been assigned to you in error.

Prerequisites
Display the lead you wish to refuse in the Leads tab.
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Steps
1. If you wish to leave the territory management program to automatically assign 

the lead to a member of the sales team, then delete any name, if any, from the 
Assign to field. 

2. If you wish to over-ride the territory assignment program and assign this lead 
to an agent manually, then use the Assign to field List of Values to enter an 
agent’s name.

3. Click Save.

Using the Opportunity Tab
Use the Opportunity tab of the eBusiness Center to manage your opportunities.

Help is available on the following:

■ Searching for and displaying an opportunity

■ Displaying the opportunities for a consumer or organization

■ Entering a note for an opportunity

■ Viewing notes for an opportunity

■ Creating an opportunity without a prior lead

■ Entering purchase interest for an opportunity

■ Entering sales credit for purchases in an opportunity

■ Entering opportunity contacts

■ Classifying an opportunity 

■ Selecting an opportunity sales team and partners

■ Viewing sales credits for an item in an opportunity

■ Viewing sales credit totals for an opportunity

■ Tracking obstacles to an opportunity

■ Closing an opportunity so you can receive sales credit

■ Assigning tasks for an opportunity

■ Viewing tasks associated with an opportunity

■ Viewing leads associated with an opportunity
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■ Viewing customer quotes and orders from the opportunity center

■ Freezing an opportunity so nobody can modify it

■ Creating a quote or order from an opportunity

■ Splitting up an opportunity if only some items can close

■ Deleting purchase items from an opportunity

■ Copying an opportunity

Searching For and Displaying an Opportunity
Use this procedure to search for an Opportunity using the Universal Search 
window and display it in the Opportunity tab of the eBusiness Center.

Prerequisites
None

Steps
1. In the eBusiness Center, select the Opportunity tab.

2. Click Search in the toolbar. 

The Universal Search window opens.

3. Enter search criteria on the Basic tab:

■ The contact name fields search the contacts listed for the opportunity. If you 
are selling to a contact at an organization, this person is automatically listed 
as a contact for the opportunity. 

■ Enter a range for win probabilities and dates. 

■ Selecting the Sales Credit check box limits your search to only those 
opportunities you are listed to receive sales credit for. Deselecting this check 
box searches for all opportunities where you are listed in the sales team 
regardless whether you receive sales credit or not.

4. If you wish to search for events by using other criteria such as the total value of 
the opportunity or the name of the sales representatives assigned to the 
opportunity, then enter additional search criteria on the Advanced tab:

a. Use the Item List of Values (LOV) to enter the criteria type.

b. Use the Condition LOV to enter the operator. 
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c. Enter the value.

For example, to search for opportunities worth more than $100,000, enter 
Total Amount for Item, > for the Condition and 100000 for the value.

5. Click Search.

The results of your search appear below.

6. If the opportunity you are looking for is not listed, then try searching with less 
restrictive search criteria. 

7. If the opportunity appears on the list, then: 

a. Select the result.

b. Click OK to display the opportunity in the Opportunity tab of the 
eBusiness Center.

Guidelines
If the opportunity you wish to work on appears in your work queue, then you can 
double-click on it in the work queue to display it in the Opportunity Center where 
you can modify it. For more information about your Work Queue see Accessing 
Leads, Opportunities, and Other Work from Your Work Queue.

Displaying Opportunities for a Consumer or an Organization
Use this procedure to display opportunities for a consumer or an organization.

Prerequisites
Display the party in the eBusiness Center header.

Steps
1. If you wish to view opportunities for a consumer, then, in the View Details For 

region, select the radio button labeled with the person’s name. This is the first 
button from the left.

2. If you wish to view opportunities for an organization, then select the radio 
button labeled with the name of the organization. This is the second button 
from the left.

3. Select the Opportunity tab.

The opportunities that have been created for this person or organization, if any, 
are listed in the left side of the tab.
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4. If you wish to view only open opportunities, then deselect the Display All 
check box.

5. Select the opportunity you wish to view or modify from the list on the left. The 
basic information about the opportunity appears on the right side of the tab. 

6. If you wish to view more details about the opportunity, then click Details to 
launch the Opportunity Center.

Entering a Note for an Opportunity
Use this procedure to enter a note on an opportunity. You can enter a note on an 
opportunity either in the Opportunity tab or in the Opportunity Center. 

Prerequisites
Display the opportunity in the Opportunity tab or in the Opportunity Center

Steps
1. Display the opportunity for which you wish to enter a note either in the 

Opportunity tab or Opportunity Center.

2. Type your note in the New Note field.

3. Click Save on the toolbar.

4. If you wish to add a second note, then:

a. Place your cursor in the New Note text field.

b. Click New in the toolbar. This is the button with a green plus sign.

c. Enter the note and click Save.

Viewing Notes for an Opportunity
Use this procedure to view the notes for an opportunity. 

Prerequisites
None 

Note: You can edit the note you have entered until you select a 
different party or start entering a new record.
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Steps
1. Display the opportunity in the eBusiness Center.

2. Click All Notes.

The Notes window appears. The left pane lists all opportunity notes.

3. To see the full text of the note, select the note you wish to view on the left. The 
text is displayed on the right.

4. You can sort notes by clicking on different column headings in the Notes tab 
list. 

References
Searching for Text Within Notes

About Notes

Creating an Opportunity Without a Prior Lead
Use this procedure to create an opportunity without a prior lead. If you wish to 
create an opportunity from an existing lead, then follow the procedure outlined in 
Turning a Lead into an Opportunity. An opportunity allows sales teams to track the 
sales process from the time a lead is qualified to the time a you create the order. 

Prerequisites
Display the party in the eBusiness Center header.

Steps
1. If you wish to create an opportunity for a consumer, then, in the View Details 

For region, select the radio button labeled with the person’s name. This is the 
first button from the left.

2. If you wish to create an opportunity for an organization, then select the radio 
button labeled with the name of the organization. This is the second button 
from the left.

3. Select the Opportunity tab.

The opportunities that have been created for this person or organization, if any, 
are listed in the left side of the tab. 

4. Click New.
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5. Enter the basic opportunity information in the fields provided. The fields 
include the opportunity name, project name, campaign, offer code, status, and 
budget.

6. To enter purchase interest and other detailed information, click Details and 
follow the procedure outlined in Entering Purchase Interest for an Opportunity.

Using the Opportunity Center
Help is available on the following topics:

■ Entering opportunity contacts

■ Classifying an opportunity 

■ Selecting an opportunity sales team and partners

■ Viewing sales credits for an item in an opportunity

■ Entering sales credit for purchases in an opportunity

■ Viewing sales credit totals for an opportunity

■ Tracking obstacles to an opportunity

■ Closing an opportunity so you can receive sales credit

■ Assigning tasks for an opportunity

■ Viewing tasks associated with an opportunity

■ Viewing leads associated with an opportunity

■ Viewing customer quotes and orders from the Opportunity Center

■ Creating a quote or order from an opportunity

■ Splitting up an opportunity if only some items can close

■ Deleting purchase items from an opportunity

■ Copying an opportunity

Note: Depending on your implementation, the status of an 
opportunity determines whether it appears in your forecast or not.
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Entering Items a Customer Wishes to Purchase in an Opportunity
Use this procedure to enter a customer’s purchase interests into an opportunity.

Prerequisites
Display the opportunity in the Opportunity tab of the eBusiness Center.

 Steps
1. In the Opportunity tab of the eBusiness Center, click Details.

The Opportunity Center launches.

2. Select the Purchase Interest tab.

3. Use the Lists of Values (LOVs) to enter the customer’s purchase interests. 

4. If you wish to create a quote, then you must enter an inventory item using the 
Inventory Id LOV and a quantity.

5. Click Save on the toolbar.

You are now ready to enter the sales credit for the purchases you have entered.

Entering Sales Credit for Purchases in an Opportunity
Use this procedure to assign sales agents and partners both revenue and 
non-revenue sales credits for the individual purchases in an opportunity. You must 
enter the sales agents and the sales credits they are to receive separately for each 
item in the opportunity. 

Prerequisites
Display the opportunity in the Opportunity tab of the eBusiness Center.

 Steps
1. Click Details.

The Opportunity Center launches.

2. Select the Purchase Interest tab.

3. Using the select field to the left of a purchase item, select the purchase item for 
which you wish to assign sales credits.

Any sales agents already receiving credit for this item are listed in the lower 
portion of the tab.
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4. From the Display drop-down list, select the type of sales credit you wish to 
assign for this item:

■ Forecast credit: Revenue credit amounts that show up in the forecasting 
module of Oracle Sales Online. 

■ Other Credit: Non-revenue credit. For example, credit toward sales quotas.

5. If you wish to modify the existing credits agents or partners are to receive for 
the item, then:

a. Modify the numbers in the Credit% field for the agent.

b. If you are modifying forecast credits, then you must modify the credit 
percentages for other agents and partners so that the total adds up to 100 
percent. 

c. Click Save on the toolbar.

6. If you wish to add any additional sales people who are to receive sales credit for 
this item, then:

a. Use the Sales Agent List of Values (LOV) to enter a sales agent. If no blank 
record lines appear, then use the New button in the toolbar to add an 
additional record.   

b. In Credit %, enter the number corresponding to the percentage of 
commission the individual is to receive. 

Any new sales person you add here is automatically added to the sales 
team for the opportunity. 

c. If you are assigning revenue credit, then adjust the credit percentages of the 
other sales agents and partners for this item so the total adds up to 100 
percent.

d. Click Save on the toolbar.

7. If you wish to add any additional partners who are to receive sales commissions 
for the sale of this item, then:

Note: The percent amounts of forecast credits you assign to sales 
team members and partners must add up to 100 because you are 
adding up actual revenue. For other non-revenue credits any 
percentage is allowed.
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a. Use the Partner Name LOV to enter a partner. If no blank record line 
appears, then use the New button in the toolbar to add an additional 
records.

b. In Credit%, enter the number corresponding to the percentage of 
commission the individual is to receive for this item. Do not enter a percent 
sign. 

c. If you are entering revenue credits, then adjust the credits of the other sales 
agents and partners, so the total adds to 100 percent.

d. Click Save on the toolbar.

Entering Opportunity Contacts
Use this procedure to enter contacts into an existing opportunity. 

Prerequisites
Display the opportunity in the Opportunity tab of the eBusiness Center.

The contacts you wish to add must already be in the database as the organizational 
contacts.

 Steps
1. Click Details.

The Opportunity Center launches.

2. Select the Contact tab.

3. Using the First Name List of Values, add the contacts.

4. If you wish to designate a contact as the primary contact for the opportunity, 
then select the Primary check box next to the record. You can only designate one 
contact as a primary contact for the opportunity.

5. Click Save on the toolbar.

Note: The percent amounts of revenue credits you assign to sales 
team members and partners must add up to 100. For non-revenue 
credits any percentage is allowed.
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Classifying an Opportunity 
Use this procedure to classify an existing opportunity. The CRM territory 
management program uses this classification to assign a sales team.   

Prerequisites
Display the opportunity in the Opportunity tab of the eBusiness Center.

 Steps
1. Click Details.

The Opportunity Center launches.

2. Select the Classification tab.

3. Use the Lists of Values to classify the opportunity according to the classification 
scheme provided by your organization.

4. Click Save on the toolbar.

Selecting an Opportunity Sales Team and Partners
Use this procedure to manually add sales agents and partners to an opportunity 
sales team. Adding someone to the sales team makes them able to view an 
opportunity and add notes and tasks. Making the individual team leader enables 
them to modify all aspects of the opportunity. If your organization has implemented 
CRM territory management module, then a sales team is assigned to an opportunity 
automatically. 

Prerequisites
Display the opportunity in the Opportunity tab of the eBusiness Center.

 Steps
1. Click Details.

The Opportunity Center launches.

2. Select the Sales Team tab.

The tab lists the current sales team.

If your organization has set up the CRM territory management module, then 
the sales team is automatically assigned to the opportunity when you create it.

3. If you wish to add a sales team member, then, in the Internal Sales region:
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a. Use the Sales Agent List of Values to add the agent. 

b. If you wish this individual to have update privileges for this opportunity, 
then select the Full Access check box. All team members have view 
privileges.

c. If you wish to keep this individual regardless of the assignment made by 
the CRM territory management module, then make sure the Keep check 
box is selected.

d. Click Save on the toolbar when you have completed adding agents.

Viewing Sales Credits for an Item in an Opportunity
Use this procedure to view sales credits for individual items in an opportunity.

Prerequisites
Display the opportunity in the Opportunity tab of the eBusiness Center.

 Steps
1. Click Details.

The Opportunity Center launches.

2. Select the Purchase Interest tab.

3. Using the select field to the left of a purchase item, select the purchase item for 
which you wish to view sales credits.

4. From the Display drop-down list, select the type of sales credit you wish to 
view for the item you have selected:

■ Forecast credit: Revenue credit amounts that show up in the forecasting 
module of Oracle Sales Online. 

■ Other Credit: Non-revenue credit. For example, credit toward sales quotas.

The sales agents and the sales credits they are to receive are listed in the lower 
portion of the tab.

Viewing Sales Credit Totals for an Opportunity
Use this procedure to view the total sales credit sales team members are to receive 
on all the purchase items in an opportunity. 
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Prerequisites
Display the opportunity in the Opportunity tab of the eBusiness Center.

 Steps
1. Click Details.

The Opportunity Center launches.

2. Select the Sales Team tab.

3. Click View Credit Total.

The Opportunity Credit Total window appears. The window lists both the 
revenue and non-revenue credit totals for each agent and partner for this 
opportunity. 

Tracking Obstacles to an Opportunity
Use this procedure to track obstacles to a sale such as competitors. 

Prerequisites
Display the opportunity in the Opportunity tab of the eBusiness Center.

 Steps
1. Click Details.

The Opportunity Center launches.

2. Select the Obstacles tab.

3. In the Competitors region, use the Lists of Values (LOVs) to enter any 
competitors and their products. You can add a free text comments in the 
Comments field.

4. If you wish to track other issues related to the opportunity, then in the Other 
Issues region:

a. Use the Issue LOV to enter an issue.

Note: The terminology in this window is different from that used 
in the Purchase Interest tab. The label Quota Sales Credit refers to 
Forecast Credit (actual revenue). The label Non-Quota Sales Credit 
refers to Other Credit. (non-revenue)
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b. Select a Status.

c. Enter a comment.

5. Click Save on the toolbar.

Closing an Opportunity So You Can Receive Sales Credit 
Use this procedure to enter or view closing information for an opportunity. To 
receive sales credit and to assure accurate pipeline reports, you must close an 
opportunity and enter a close reason after placing an order for a customer.

Prerequisites
Display the opportunity in the Opportunity tab of the eBusiness Center.

 Steps
1. Click Details.

The Opportunity Center launches.

2. Select the Close Reason tab.

3. Use the Close Reason List of Values (LOV) to enter the close reason.

4. If this opportunity has been won, then the resulting orders are listed in the Win 
region.

5. If you lost the order, then enter the competitor using the LOV provided and any 
comment.

6. If the opportunity resulted in a sale by a reseller, then add the information in 
the Reseller Information region.

7. Enter the rest of the closing information for the opportunity. Depending on your 
implementation you may be required to enter:

■ Win Probability

■ Close Date

■ Sales Stage

8. Change the Status. If you made the sale, then change the status to won. 

Note: To change the status of an opportunity to Won, Lost, or No 
Opportunity, you must enter the close reason first. 
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9. Click Save on the toolbar.
 

Assigning Tasks for an Opportunity
Use this procedure to assign a task for an existing opportunity. The task you assign 
here appears on the work queue of the individual you enter as the owner of the 
task. This task also remains visible in this task tab. All members of the sales team 
can view, create, and edit tasks.

Prerequisites
Display the opportunity in the Opportunity tab of the eBusiness Center.

 Steps
1. Click Details.

The Opportunity Center launches.

2. Select the Task tab.

3. Click New.

4. Use the Lists of Values (LOVs) to enter the task type and priority.

5. Enter a name.

6. Enter a date you wish this task to be performed in the Planned Start field.

7. In Owner, use the LOV to enter the person who is being assigned this task.

8. Enter a description.

9. Click Save on the toolbar.

Note:  Changes made in Opportunity Center are not immediately 
reflected in the Opportunity tab. You must refresh the eBusiness 
center display first.

Note: This release of Oracle TeleSales does not assign tasks by the 
Assign To field, but by assigning an owner to the task. The task 
appears in the work queue of the person designated as the owner.
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Viewing Tasks Associated with an Opportunity
Use this procedure to view tasks associated with an opportunity.

Prerequisites
Display the opportunity in the Opportunity tab of the eBusiness Center.

 Steps
1. Click Details.

The Opportunity Center launches.

2. Select the Task tab.

3. The tasks associated with this opportunity are listed on the left.

4. Selecting the Display All check box, lists both open and closed tasks.

5. Select a task on the list to view its details on the right.

6. If you wish to see further details, then click Details.

The details of the task are displayed in the Task window. See Oracle CRM 
foundation documentation for information on how to use the task manager.

Viewing Leads Associated with an Opportunity
Use this procedure to view any leads that were used to create an opportunity. 

Prerequisites
Display the opportunity in the Opportunity tab of the eBusiness Center.

 Steps
1. Click Details.

The Opportunity Center launches.

2. Select the Leads tab.

3. The leads that were used to create this opportunity are listed.

4. If you wish to view any of the leads, then:

a. Select the lead.

b. Click Lead Center.
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c. If you wish to view details of multiple leads, then select the Display 
Multiple Lead Centers check box.

Viewing a Customer’s Quotes and Orders for a Specific Opportunity
Use this procedure to view a customers past orders and quotes. 

Prerequisites
Display the opportunity in the Opportunity tab of the eBusiness Center.

 Steps
1. Click Details.

The Opportunity Center launches.

2. Select the Quotes/Orders tab.

3. If you wish to previous orders from the customer, then:

a. From the View drop-down list, select Orders.

The customer’s orders in accounts receivables are listed in the tab.

b. Select an order you wish to view.

c. Click Details to view details of the order in a separate window in Oracle 
Order Management.

4. If you wish to view quotes for this customer, then:

a. From the View drop-down list, select Quotes.

The customer’s quotes are listed in the tab.

b. Select a quote you wish to view or modify.

c. Click Details to view details of the quote in an Oracle Order Capture 
window.

Freezing an Opportunity So Nobody Can Modify It
Use this procedure to freeze an opportunity so it cannot be modified. After an 
opportunity is frozen, nobody, including the person who froze the opportunity, can 
make any modification unless they obtain permission from the application 
administrator.
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Prerequisites
You must be on the sales team for the opportunity to freeze it.

Steps
1. Display the opportunity in the Opportunity tab of the eBusiness Center.

2. Select the Freeze check box.

3. Click Save in the toolbar.

Guidelines
An opportunity with the Freeze check box selected can only be updated by people 
with special responsibility which is set up by your application administrator using 
the Update Frozen Opportunities system profile option.

Creating a Quote or Order from an Opportunity
Use this procedure to create a quote from an opportunity. You must enter an 
inventory item as a purchase interest before you can create a quote or order 

Prerequisites
Display the opportunity in the Opportunity tab of the eBusiness Center.

Before you can create an order, you must enter the ship to and bill to address.

 Steps
1. Click Details.

The Opportunity Center launches.

2. Select the Purchase Interest tab.

3. Enter inventory items and quantities for the purchase interest.

4. Click Create Quote in the Opportunity Center header.

The Order Capture window opens. Follow the instructions outlined in the 
Oracle Order Capture documentation for preparing quotes and booking orders.

5. You must close the opportunity so you and others on the opportunity sales 
team can receive sales credit.
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Splitting Up an Opportunity If Only Some Items Can Close
Use this procedure to split up an opportunity so that you can close on some 
purchase items while others remain open. You first make a copy of the opportunity 
and then specify the items you wish to split by making deletions from the copy and 
the original.

Prerequisites
Display the opportunity in the Opportunity tab of the eBusiness Center.

 Steps
1. Click Details.

The Opportunity Center launches.

2. Click Copy.

The Opportunity Center displays the copy you have made. The only 
information changed is the opportunity number which is automatically 
incremented by one.

3. Rename the copy you have made.

4. Delete the purchase items which are to close from the copy.

5. Click Save in the toolbar.

6. Navigate to the eBusiness Center.

7. From the list on the Opportunity tab, select the opportunity you have copied.

8. Click Details.

The Opportunity Center displays.

9. Delete the purchase items which are in the copy you have made.

10. Click Save in the toolbar.

Deleting Purchase Items from an Opportunity
Use this procedure to delete purchase items from an opportunity.

Prerequisites
Display the opportunity in the Opportunity tab of the eBusiness Center.

You must be designated as a team leader on the opportunity sales team.
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 Steps
1. Click Details.

The Opportunity Center launches.

2. Select the Purchase Interest tab.

3. Select the purchase item you wish to delete.

4. Click Clear Record on the toolbar.

Copying an Opportunity
Use this procedure to copy an opportunity. You will want to copy an opportunity if 
you wish to split an opportunity

Prerequisites
Search for and display the opportunity.

 Steps
1. Click Details.

The Opportunity Center launches.

2. Click Copy.

The Opportunity Center displays the copy you have made. The only 
information changed is the opportunity number which is automatically 
incremented by one.

Updating Opportunities
You can update opportunities in one of three ways:

■ Update opportunities one at a time using the Opportunity Center

■ update the win probabilities, sales stages, close dates, and channel fields for a 
list of opportunities using the mass opportunity window. You create a list using 
the Lookup Center and update all opportunities on that list to the values you 
enter in the Mass Opportunity Update window.

■ Update multiple opportunities in one window. This method allows you query 
up the opportunities you wish to modify and modify each opportunity 
individually in one window.
Using the eBusiness Center 113



Using the Opportunity Tab
Updating an Individual Opportunity
Use this procedure to update an individual opportunity in the Opportunity tab of 
the eBusiness center. 

Prerequisites
The opportunity must be created first.

Steps
1. Display the opportunity in the Opportunity tab of the eBusiness Center. 

2. Click Details.

3. The Opportunity Center window appears.

4. Update the opportunity. You can: 

■ Enter opportunity contacts

■ Enter items a customer wishes to purchase

■ Enter sales credit for purchases in an opportunity

■ Create a quote or order from the opportunity 

■ Close the opportunity so you can receive sales credit

■ Classify the opportunity 

■ Select the sales team and partners

■ Track obstacles to the opportunity

■ Assign tasks to others regarding this opportunity

■ View customer quotes and orders

■ Split up the opportunity if only some items can close

■ Delete purchase items from an opportunity

Updating a List of Opportunities
Use this procedure to update the win probabilities, sales stages, close dates, and 
channel fields for a list of opportunities. If you wish to open multiple opportunities 
in one window so you can update their values one at a time, then you must instead 
use the Pipeline Management window. See Updating Multiple Opportunities in 
One Window.
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Prerequisites
You must first create a list of opportunities you wish to update.

Steps
1. Navigate to Mass Opportunity Update.

The Mass Update of Opportunities window opens.

2. Click Search.

The opportunities on the list display below.

3. Use the Lookup Name List of Values (LOV) to find the list of opportunities you 
wish to update.

4. Select the opportunities you wish to update, by selecting the Select check box 
for each.

5. Make entries in the win %, sales stages, close dates, and channel fields for each 
entry.

6. Click Mass Update.

Updating Multiple Opportunities in One Window
Use this procedure to update multiple opportunities at the same time using the 
pipeline management window.

Prerequisites
None

Steps
1. From the Navigator, select Pipeline Management.

The Pipeline Search Criteria window appears.

2. Enter your search criteria.

■ You can use the % sign to substitute for any missing characters.

■ You can enter one value or a range of values for win probability, close date, 
total amount, and sales credit amount.

■ Select one of the Credits radio buttons to search for opportunities with 
forecast credits, other (non-revenue) credits, or both, for the agent listed in 
the Sales Agent field.
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3. If you belong to or manage multiple sales groups, then you can restrict the 
search to a particular sales group by selecting that sales group from the Sales 
Group List of Values (LOV). 

4. If you manage a sales group, you can restrict the search to a single member of 
the sales group. To do so, use the Sales Agent field LOV to enter the name of the 
subordinate.

 

5. Click Search.

The Pipeline Search Results window appears displaying the results of your 
search.

6. If you need to modify the search, then click Return to Search to return to the 
Pipeline Search Criteria window.

7. If you wish to update the win probability (Win %), status, close date, channel, 
sales stage, or close reason for an opportunity, then make your entry in the list 
of opportunities.

8. If you wish to view the total revenue amount of the opportunities listed, then 
click Calculate. 

9. If you wish to change the purchase interest for an opportunity, then:

a. Select the opportunity you wish to modify from the list at the top of the 
window. You can click in any field to select an opportunity.

The purchase interest information for that opportunity appears below.

b. Make your modifications. 

Note: The application uses the logical AND to connect your 
search criteria. Each field you enter restricts your search further.

Note: If you do not manage a sales group, you can only search for 
your own opportunities. In this case, your name prefills the Sales 
Agent field automatically.

Note: You must use the scroll bar to reveal the Sales Stage and 
Close Reason fields.
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10. If you wish to modify the sales credit for individual items in an opportunity, 
then:

a. Select the opportunity you wish to modify from the list at the top of the 
window.

The purchase interest information for that opportunity appears below.

b. Select the item.

c. From the Display drop-down list, select Forecast Credit or Other Credit.

d. Modify the credit amounts for the item.

11. Click Submit Changes to save your work.

12. If you wish to close the window, then from the File menu, choose Close Form.

Note: You must use the scroll bar to reveal the quantity, purchase 
amount and other fields.
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Using the Quote and Order Tab
Use the Quote/Order tab of the eBusiness Center to view a list of quotes and orders 
and to launch Oracle Order Capture, the application where you create customer 
quotes and place orders.

You can obtain help on:

■ Viewing and modifying quotes

■ Viewing and modifying orders

■ Creating a quote or an order without a lead or an opportunity 

Viewing and Modifying Quotes
Use this procedure to view or modify a quote for a customer. 

Prerequisites
Display the party in the eBusiness Center header.

Steps
1. If you wish to view the quotes for a consumer, then, in the View Details For 

region, select the radio button labeled with the person’s name. This is the first 
button from the left.

2. If you wish to view the quotes for an organization, then, in the View Details For 
region, select the radio button labeled with the organization’s name. This is the 
second button from the left.

3. Select the Quote/Order tab.

4. From the View drop-down list, select Quotes.

The tab displays the list of quotes.

5. Select a quote from the list.

6. Click Details.

Note: You cannot view quotes for a contact at an organization. 
View the quotes for an organization instead.
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Oracle Order Capture appears displaying the quote. Follow the procedures 
outlined in the Oracle Order Capture documentation to modify quotes.

Viewing and Modifying Orders
Use this procedure to view or modify an order for a customer. 

Prerequisites
Display the party in the eBusiness Center header.

Steps
1. If you wish to view the orders for a consumer, then, in the View Details For 

region, select the radio button labeled with the person’s name. This is the first 
button from the left.

2. If you wish to view the orders for an organization, then, in the View Details For 
region, select the radio button labeled with the organization’s name. This is the 
second button from the left.

3. Select the Quote/Order tab.

4. From the View drop-down list, select Orders.

The tab displays the list of orders.

5. Select an order from the list.

6. Click Details.

The Order Organizer window from Oracle Order Management appears 
displaying the order. Follow the procedures outlined in the Oracle Order 
Management documentation to view and modify orders.

Creating a Quote or an Order Without a Lead or Opportunity 
Use this procedure to create a quote or an order for a consumer or an organization 
directly without using an opportunity to track the sales process. 

Note: You cannot view orders for a contact at an organization. 
View the orders for an organization instead.
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Prerequisites
Display the party in the eBusiness Center header.

Steps
1. If you creating a quote or an order for a consumer, then, in the View Details For 

region, select the radio button labeled with the person’s name. This is the first 
button from the left.

2. If you creating a quote or an order for an organization, then, in the View Details 
For region, select the radio button labeled with the organization’s name. This is 
the second button from the left.

3. If you are creating an order, then you must enter the billing and shipping 
addresses. 

4. Select the Quote/Order tab.

5. Click New.

The Order Capture window opens. Follow the instructions outlined in the 
Oracle Order Capture documentation for preparing quotes and booking orders.

Note: You cannot create a quote or an order for a contact at an 
organization. Create it for the organization instead.
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Using the Event Tab
Use the Event tab of the eBusiness Center to enroll customers or prospects in events 
and send out confirmations. 

Click here for a detailed overview of this tab.

Help is available on the following tasks:

■ Searching for an event using multiple search criteria

■ Displaying an event

■ Viewing enrollment and other event information

■ Choosing events and adding enrollees

■ Completing enrollment and sending out confirmations

■ Creating contacts or consumers for enrollment and collateral shipment

■ Viewing enrollment history

Searching for an Event Using Multiple Search Criteria
Use this procedure to search for events in the Event tab using multiple search 
criteria. 

Prerequisites
None

Steps
1. In the eBusiness Center Event tab, click Search Event. 

The Universal Search window opens.

2. Enter search criteria on the Basic tab. 

Note: This version of the application does not support payments 
for events.

Note: The event date fields refer to the dates the event starts and 
finishes, not a date range.
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3. If you wish to search for events by language, cost, city, state, province, and 
country or if you wish to search for events depending on whether they are by 
invitation only or open to all, then enter additional search criteria on the 
Advanced tab:

a. Use the Item List of Values (LOV) to enter the criteria type.

b. Use the Condition LOV to enter the operator. 

c. Enter the value.

For example, to search for an event costing less than $100, enter Cost for 
Item, < for the Condition and 100 for the value.

4. Click Search.

The results of your search appear below.

5. If the event you are looking for is not listed, then try searching with less 
restrictive search criteria. 

6. If the event appears on the list, then: 

a. Select the result.

b. Click OK to display the event in the Event tab of the eBusiness Center.

Displaying an Event
Use this procedure to display an event in eBusiness Center Event tab.

Prerequisites
None

Steps
1. Navigate to the Event tab.

2. If the Event tab already displays another event, then:

a. Place your cursor in the Campaign or Event Name fields.

b. Click New in the toolbar.

3. If your organization has many events, then use the Campaign List of Values 
(LOV) to enter a campaign. Entering a campaign restricts the number of events 
displayed in the Event Name LOV.

4. If you know the name of the event, then use the Event Name LOV to enter it.
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5. If you do not know the event name, or wish to search by some other criteria 
such as the date the event is being offered, then click Search Event to search for 
it.

6. If you wish to view enrollment, availability, and other information about the 
event, then click Item Details in the Item View region and follow the procedure 
described in Viewing Enrollment and Other Event Information.

References
Click here for a detailed overview of the Event tab.

Viewing Enrollment and Other Event Information
Use this procedure to view enrollment and detailed information about an event. 
This can include detailed descriptions of the event agenda, the venue, driving 
directions, and collateral associated with the event. What information you can view 
depends on the information entered in Oracle Marketing Online.

Prerequisites
Display the event in the Event tab of the eBusiness Center.

Steps
1. With the event displayed in the Event tab, click Item Details.

The Enrollment Details window appears displaying the number of available 
spots, enrollment totals, as well as a listing the enrollees in the event.

The Main Contact listed is the person who spoke with the agent to make the 
enrollment. The main contact may or may not be an enrollee.

2. If you wish to view details about the event, then: 

a. From the View By drop-down list, select Information. 

The window displays available information and collateral.

b. In the Available Event Information region, select an item you wish to view 
in full in the description field to the right.

Important Note: In this release, the information in this window is 
for viewing only. You cannot use this window to select or send any 
collateral or cover letters as these features are disabled.
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References
Click here for a detailed overview of the Event tab.

Recording Attendance at an Event
Use this procedure to add information about whether an enrollee attended the 
event and where they enrolled.

Prerequisites
Display the event in the Event tab of the eBusiness Center.

Steps
1. With the event displayed in the Event tab, click Item Details.

The Enrollment Details window appears listing the enrollees in the event.

2. Make sure Roster is selected in the View By drop-down list.

3. For each event enrollee whose attendance you wish to record:

a. Select the enrollee(s) in the list. You can select multiple enrollees using the 
shift or CTRL keys on your keyboard.

b. In the Roster region at the bottom of the window, use the Attended List of 
Values (LOV) select Y (Yes) or N (No).

c. Using Source LOV, select who enrolled the individual.

d. Click Update.

Choosing Events and Adding Enrollees
Use this procedure to start the enrollment process for small numbers of people in an 
event. This procedure tells you how to choose events and add enrollees. 

If you are enrolling a large number of people, then follow the procedure for 
enrolling lists of contacts instead.

Prerequisites
Display the party in the eBusiness Center header.
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Steps
1. If you are enrolling consumers, then, In the View Details For region, select the 

radio button labeled with the name of the consumer. This is the first button 
from the left.

2. If you are enrolling contacts at an organization, then, In the View Details For 
region, select the radio button labeled with the name of the person and the 
organization. This is the third button from the left. If this button is disabled, you 
can also enroll contacts with the organization button selected.

3. Select the Event tab.

4. If you know the campaign associated with the event, then use the List of Values 
(LOV) to enter a campaign. This field restricts which events are displayed in the 
Event Name LOV. 

5. If you know the name of the event, then use the Event Name LOV to enter it.

6. If you do not know the event name, or wish to search by some other criteria 
such as the date the event is being offered, then click Search Event to search for 
it.

Information about the event displays in the Event Description and Item View 
regions of the Event tab. 

The Spots field in the Item View region displays the number of available spots.

7. If you wish to view enrollment, availability and other information about the 
event, then click Item Details. For more information see Viewing Enrollment 
and Other Event Information.

8. If the customer does not wish to enroll in this event but would like to view 
another, then:

a. Check if the Item # field shows there is more than one event available for 
view.

b. If additional items are available, then you can navigate to the other events 
using the arrow keys.

Note: You are not restricted to enrolling a contact in the events 
tied to a particular campaign. You can enroll contacts in events 
from multiple campaigns. You must have at least one campaign 
associated with the order, however.
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c. If no additional events are ready for view, then place your cursor in either 
the Campaign or Event Name fields, click New in the toolbar and enter 
another event.

9. If the contact wishes to enroll people in this event then: 

a. Click Add to Cart. 

b. Use the Enrollees field LOV to add contacts. If you require additional entry 
fields, click New on the toolbar or press down arrow on the keyboard to 
create them.

c. If you do not know the name of the people who will be attending, then add 
the person making the arrangements as a place holder for each of the 
enrollees.

You can use the name of one contact to reserve multiple spots.

d. If the individuals you wish to enroll do not appear on the Enrollees LOV, 
then either add the new enrollee as a contact or use another name as a place 
holder.

The enrollees you enter are saved temporarily while you work with this 
customer, so you need not save each one individually.

e. When you are done adding enrollees for this event, you can display another 
event and add enrollees to it.

10. When you have completed adding all events and enrollees, click Enroll to 
complete the enrollment and send out confirmation emails.

References
Click here for a detailed overview of the Event tab.

Completing Your Enrollment Order and Sending Out a Confirmation
Use this procedure to complete the enrollment for the events in your cart and to 
send out a confirmation email to the main contact.

Prerequisites
You must first choose the event and add enrollees in the Event tab first or use the 
mass enrollment procedure before you can complete the process.
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Steps
1. In the Event tab, click Enroll.

The Event Registration Review window appears listing the events and enrollees 
for your order.

2. Use the Confirmation Letter List of Values (LOV) to select the email the main 
contact is to receive. The main contact is the party who requested the order.

3. The Shipping Method is E-Mail. This is the only type of confirmation available 
in this release.

4. Use the Mail to LOV to enter an email address.

5. Click Enroll.

The application adds the confirmation number and enrollment status to the 
enrollee information in the list above.

6. When you have completed the enrollment process for each enrollee, then click 
Close.

Guidelines
The application administrator can specify the email address enrollees can reply to 
and the subject line of the email confirmation message by setting the following 
system profile options:

■ OTS: Default Event Reply to Email Address

■ OTS: Default Event Subject Line

References
Click here for a detailed overview of the Event tab.

Note: If the Enroll button is disabled, this means that you have 
not added any events to the cart.

Note: The payment information in this window is not functional 
in this release.
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Creating Contacts or Consumers for Enrollment and Collateral
Use this procedure to create new organizational contacts or consumers so you can 
email them collateral or add them as enrollees in an event. This procedure provides 
an alternate way of creating parties in your database.

Prerequisites
You can only access this method from the 

Steps
1. If you are in the Event tab, then click New Contact.

2. If you are in the Collateral tab, then click New Party.

The Creation of Party window appears.

3. From the Party Type drop-down list, select the party type you are creating:

■ Person: to create a consumer.

■ Party Relationship: to create a contact at an organization.

4. If you are creating a contact at an organization, then the Organization field 
prefills automatically with the name of the organization. 

5. Enter the individual’s name.

6. If you are creating a contact at an organization, then use the Relation List of 
Values (LOV) to enter a relationship. Usually this is "Contact".

7. Enter the person’s email address. You need this to send the confirmation email 
and electronic collateral.

8. Enter other contact information.

9. Click OK. 

Viewing Enrollment History
Use this procedure to view the enrollment history for a consumer, a contact at an 
organization, or for all the organization as a whole.

Note: You cannot view information relating to payments for 
events in this release.
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Prerequisites
Display the party in the eBusiness Center header.

Steps
1. If you wish to view the enrollment history of a consumer, then, In the View 

Details For region, select the radio button labeled with the name of the 
consumer. This is the first button from the left.

2. If you wish to view the enrollment history of the whole organization, then, In 
the View Details For region, select the radio button labeled with the name of the 
organization. This is the second button from the left. 

3. If you wish to view the enrollment history of a specific contact at an 
organization, then, In the View Details For region, select the radio button 
labeled with the name of the person and the organization. This is the third 
button from the left. 

4. Select the Event tab.

5. Click Event History.

The Customer Event History window appears showing the enrollment history 
for the individual or organization you selected in View Details For.

The Main Contact field lists the individual who made the enrollment. The 
Enrollee Name displays the actual person enrolled.

6. If you are viewing enrollment for an organization and wish to view only the 
enrollment for a specific contact at the organization, then:

a. Use the Contact Name field List of Values (LOV) to select the name of the 
contact.

b. Click Find.

The window displays the enrollment history for that contact only.

7. If you wish to view the details of any of the enrollments such as enrollment 
status, then select the event in the list. The details appear in the fields below.

8. Click Cancel when you are done reviewing event history.

References
Click here for a detailed overview of the Event tab.
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Using the Collateral Tab
Use the Collateral tab of the eBusiness Center to send electronic collateral to 
customers and prospects.

Help is available on the following:

■ Creating contacts or consumers for enrollment and collateral shipment

■ Searching for collateral using multiple search criteria

■ Preparing an order to email collateral to a contact or a consumer

■ Completing the order to email collateral

■ Viewing collateral history

Searching for Collateral Using Multiple Search Criteria
Use this procedure to search for collateral in the Collateral tab using multiple search 
criteria. 

Prerequisites
None

Steps
1. In the eBusiness Center Collateral tab, click Search. 

The Universal Search window opens.

2. Enter search criteria on the Basic tab. 

3. If you wish to search for collateral by other criteria such as language, or 
available quantity, then enter additional search criteria on the Advanced tab:

a. Use the Item List of Values (LOV) to enter the criteria type.

b. Use the Condition LOV to enter the operator. 

c. Enter the value.

Note: The collateral Release Date fields allow you to search for 
collateral released between the start and end dates you enter.
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For example, to search for collateral where the available quantity is more 
than 100 pieces, enter Qty Avail for Item, > for the Condition and 100 for 
the value.

4. Click Search.

The results of your search appear below.

5. If the collateral you are looking for is not listed, then try searching with less 
restrictive search criteria. 

6. If the collateral appears on the list, then: 

a. Select the result.

b. Click OK to display the collateral in the Collateral tab of the eBusiness 
Center.

Preparing an Order to Email Collateral to a Contact or a Consumer
Use this procedure to create an order to email electronic collateral to a consumer or 
a contact at an organization. 

Prerequisites
Display the party in the eBusiness Center header.

Steps
1. If you wish to send collateral to a consumer, then, In the View Details For 

region, select the radio button labeled with the name of the consumer. This is 
the first button from the left.

2. If you wish to send collateral to someone at an organization, then, In the View 
Details For region, select the radio button labeled with the name of the 
organization. This is the second button from the left. 

3. For each piece of collateral you wish to add to the order:

a. If you know the campaign the collateral is associated with, then enter it in 
the Campaign field. This name is prefilled if you had entered a campaign in 
the Overview tab. An entry in this field restricts the number of collateral 
available in the Collateral Name LOV.

b. If you know the name of the collateral you wish to send, then use the Name 
LOV in the Collateral Description region to enter it.
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c. If you do not know the collateral name, or wish to search by some other 
criteria such as the available quantity or release date, then click Search to 
search for it.

The Collateral Description region displays basic information about the 
collateral. 

d. In the Contact field, use the LOV to enter the name of the individual you 
wish to email the collateral to. This field may already be prefilled.

e. Select EMAIL as the shipping method.

f. Use the Mail To LOV to select the email address.

g. Use the Cover Letter Email LOV to enter the email for the contact that will 
be used to send a confirmation email. This may be the same as the Mail To 
email.

h. Click Add to Cart.

4. When you are done, click View Cart to complete the procedure for creating an 
order to email collateral. You must complete this last step for the collateral to be 
emailed out.

Completing the Order to Email Collateral
Use this procedure to request email delivery of collateral added to the cart on the 
Collateral tab of the eBusiness Center. This procedure requests the collateral to be 
emailed. It is up to the 1-1 Fulfillment module of the CRM eBusiness Suite to ensure 
they are.

Prerequisites
Prepare the collateral for mailing in the Collateral tab.

Steps
1. On the Collateral tab of the eBusiness Center, click View Cart.

Note: In this release, the Mail List of Values uses the email 
addresses from the party type of person (the consumer) and not the 
party relationship (organizational contact). You must enter the 
contact’s email address as an email address in the party type of 
person for it to appear here.
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The Collateral Request Confirmation window appears.

2. Select the collateral you wish to send.

3. Click Send Request.

Viewing Collateral History
Use this procedure to view the status of requests you have submitted for the 
emailing of collateral.

Prerequisites
Display the party in the eBusiness Center header.

Steps
1. If you wish to view a record of the collateral you requested to be sent to a 

consumer, then, In the View Details For region, select the radio button labeled 
with the name of the consumer. This is the first button from the left.

2. If you wish to view a record of the collateral you requested to be sent to an 
organization, then, In the View Details For region, select the radio button 
labeled with the name of the organization. This is the second button from the 
left. 

3. If you wish to view a record of collateral you requested to be sent to a contact at 
an organization, then, In the View Details For region, select the radio button 
labeled with the names of the contact and the organization. This is the third 
button from the left. 

4. On the Collateral tab, click History.

The Request History window appears listing the requests.

5. To view more details about an individual request:

a. Open up the request by clicking on the node labeled with a +.

b. Click on the line immediately below to display the details of the collateral 
that was requested.

6. Click OK to close the window.
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Using the Task Tab
Use the Task tab in the eBusiness Center to view and create general tasks for a 
consumer, an organization, or an organizational contact. The task you create here 
appears in the Work Queue of the individual you assign as the owner of the task.

If you wish to view or create tasks specific to an opportunity or a lead, then use the 
Lead or Opportunity tabs instead.

Help is available on the following:

■ Viewing tasks assigned for a consumer, an organization, or a contact

■ Creating a task for a consumer, an organization, or a contact

Viewing Tasks Assigned for a Consumer, an Organization, or a Contact
Use this procedure to view all of the tasks assigned to agents regarding a consumer, 
an organization, or an organizational contact. If you wish to view tasks assigned to 
you, then use the work queue instead.

Prerequisites
Display the party you wish to create a task for in the eBusiness Center header.

Steps
1. If you wish to view the tasks relating to a consumer, then, In the View Details 

For region, select the radio button labeled with the name of the consumer. This 
is the first button from the left.

2. If you wish to view the tasks relating to an organization, then, In the View 
Details For region, select the radio button labeled with the name of the 
organization. This is the second button from the left. 

3. If you wish to view the tasks relating to a contact at an organization, then, In the 
View Details For region, select the radio button labeled with the names of the 
contact and the organization. This is the third button from the left. 

4. Select the Task tab.

5. The tasks associated with this party are listed on the left.

6. Selecting the Display All check box, lists both open and closed tasks.

7. Select a task on the list to view its details on the right.

8. If you wish to see further details, then click Details.
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The details of the task are displayed in the Task window. See Oracle CRM 
foundation documentation for information on how to use the task manager.

Creating a Task for a Consumer, an Organization, or a Contact
Use this procedure to create a task for a consumer, an organization, or an 
organizational contact. The task you create will appear in the Work Queue of the 
individual you assign as the owner of the task.

If you wish to assign a task for an opportunity or a lead, then crate the task in the 
Lead or Opportunity tabs instead. Where you create a task determines how a task is 
categorized in the work queue.

Prerequisites
Display the party you wish to create a task for in the eBusiness Center header.

Steps
1. If you wish to create a task for a consumer, then, In the View Details For region, 

select the radio button labeled with the name of the consumer. This is the first 
button from the left.

2. If you wish to create a task for an organization, then, In the View Details For 
region, select the radio button labeled with the name of the organization. This is 
the second button from the left. 

3. If you wish to create a task for a contact at an organization, then, In the View 
Details For region, select the radio button labeled with the names of the contact 
and the organization. This is the third button from the left. 

4. In the Task tab, click New.

5. Use the Lists of Values (LOVs) to enter the task type and priority.

6. Enter a name for the task.

7. Enter a date you wish this task to be performed in the Planned Start field.

8. In Owner, use the LOV to enter the person who is being assigned this task.

Note: This release of Oracle TeleSales does not assign tasks by the 
Assign To field, but by assigning an owner to the task. The task 
appears in the work queue of the person designated as the owner.
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9. Enter a description.

10. Click Save on the toolbar.
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Using the Lookup Center

Use this window and those you launch from it to create and manage lists. You can 
use the Lookup Center to create lists of hot leads and opportunities, for example, or 
a list of customers for mailing collateral.

Help is available on the following topics:

■ Creating a list

■ Displaying a list

■ Modifying list availability and description

■ Exporting a list to a text file

■ Saving search criteria for frequently generated lists

Creating a List
Use this procedure to create a list. You can create a list of consumers, contacts at an 
organization, organizations, leads, opportunities, quotes, campaigns, events, and 
collateral.

You can send collateral to a list of customers and you can update all opportunities 
on a list at the same time using the Mass Opportunity window. You can also export 
a list for use on your desktop computer.

Prerequisites
None

Steps
1. Navigate to the Lookup Center.

2. Click New Lookup.

The Universal Search window appears.

3. If you wish to use search criteria you have saved previously in a folder, then:

a. Click Open Folder.

The Open Folder window appears.
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b. Select the search criteria you wish to use form the list.

c. Click OK.

4. If you wish to enter new search criteria, then follow the procedure outlined in 
Entering Search Criteria for Lookups.

5.  Click Search.

The results of your search appear in the list below.

6. To save the list: 

a. Click Save Lookup.

The Save Lookup window appears.

b. Enter a name for the list.

c. If you wish to assign the list to a sales group, then use the Assign to Group 
List of Values (LOV) to enter the group. Otherwise leave this field blank.

d. If you wish to keep the list private, so that it is visible only to you, then 
select the Private radio button.

e. If you wish to make this list accessible to others in your organization, then 
select the Internal radio button.

f. If you wish this list to be available to your organization and to partners, 
then select the Partner radio button.

g. Click OK to display the result in the eBusiness Center.

References
See About Creating Lists for an overview of lists in Oracle TeleSales.

Entering Search Criteria for Lookups
Use this procedure to enter search criteria into the Universal Search window for 
creating lists (lookups).

Prerequisites
Use this procedure only while creating lists (lookups).

Steps
1. From the Find drop-down list, select the type of list you wish to generate. 
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2. Enter search criteria on the Basic tab.

The window displays different fields depending on the on list you are 
generating. 

The search combines the different search criteria you enter using the logical 
AND. This means that entering two search criteria returns only results 
matching both search criteria. For example, searching on a partial name and a 
partial phone number returns only individuals whose names and phone 
numbers match both.

You can search on partial numbers or words provided you use the wild card % 
to indicate missing or unknown characters. For example, a search for j%n in the 
First name field retrieves all first names starting with the letter j and ending 
with the letter n, including John, Jon, and Johann.

3. If you wish to search by criteria not available on the Basic tab, then enter 
additional search criteria on the Advanced tab:

a. Use the Item List of Values (LOV) to enter the criteria type. 

b. Use the Condition LOV to enter the operator. 

c. Enter the value.

For example, to search for an event costing less than $100, enter Cost for 
Item, < for the Condition and 100 for the value.

Displaying a List
Use this procedure to display a list you have generated using the Lookup Center 
window.

Prerequisites
The list must be created first.

Note: Using the Basic tab of the Universal Search window, you 
can only search on the primary address, email, and URL. If you 
wish to search on all addresses, email addresses, and URLs, then 
you must enter the search criteria on the Advanced tab.
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Steps
1. Navigate to the Lookup Center.

2. From the Find drop-down list, select the type of list you wish to view.

The Lookup Center displays a list of the lists you and others in your 
organization have generated.

3. Select a list.

4. Click View Lookup.

The Lookup Results window displays the list. The owner of the list is the list 
creator.

Modifying List Availability and Description
Use this procedure to modify a list you have generated in the Lookup Center. You 
can only modify the description and list availability to others in your organization. 
You cannot rename, delete, or modify entries in the list. If you wish to modify the 
list entries, you must instead create a new list.

Prerequisites
The list must be created first.

Steps
1. Navigate to the Lookup Center.

2. From the Find drop-down list, select the type of list you wish to modify.

The Lookup Center displays a list of the lists you and others in your 
organization have generated.

3. Select a list.

4. Click View Lookup.

The Lookup Results window displays the list. The owner of the list is the list 
creator.

5. If desired, modify the description of the list.

6. If desired, change the availability of the list to others in and outside of your 
organization. Select one of the following radio buttons:

■ Private: To keep the list private, so that it is visible only to you.
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■ Internal: If you wish to make this list accessible to others in your 
organization.

■ Partner: If you wish this list to be available to others in your organization 
and to partners.

7. Click Save Lookup to save your changes.

Exporting a List to a Text file
Use this procedure to export a list you have generated using the Lookup Center 
window into a text file. The text file you generate is located in the server directory 
set up by your application administrator.

Prerequisites
The list must be created first.

Steps
1. Navigate to the Lookup Center.

2. From the Find drop-down list, select the type of list you wish to export.

The Lookup Center displays a list of the lists you and others in your 
organization have generated.

3. Select a list.

4. Click View Lookup.

The Lookup Results window displays the list. The owner of the list is the list 
creator.

5. Click Export Lookup.

The list is exported to a text file in the location shown in the message bar at the 
bottom of the window.

Saving Search Criteria for Frequently Generated Lists
Use this procedure to save the search criteria for generating lists. The saved criteria, 
called a folder, allow you to regenerate a list frequently. You will want to do this, for 
example, if you wish to keep an up-to-date list of your hot leads or the 
opportunities that are to close this week.
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Prerequisites
None

Steps
1. Navigate to the Lookup Center.

2. Click New Lookup.

The Universal Search window appears.

3. Enter the search criteria.

4. Click Search.

5. Check the results of your search to make sure the criteria give you the desired 
result.

6. If the results are satisfactory, then click Save Folder.

The Save Folder window appears listing your previously saved folders.

7. Enter the name of the folder.

8. Click Save.
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Administering Oracle TeleSales

This group of topics explains how to administer different functions of Oracle 
TeleSales. Depending on your implementation, these procedures may be restricted 
to applications administrators only.

Administering Leads
Use this procedure to administer leads.

Steps
1. Under the TeleSales Administrator responsibility, navigate to Lead 

Administration.

2. Select the Rank Mapping tab.

3. Enter the lead score ranges and their ranks.

The ranges of values determine how the points assigned to each lead by the 
score card are mapped into lead ranks.

The greater the number of points assigned by the score card, the hotter the lead. 
For this reason, assign the low scores to the low lead ranks and the high scores 
to the hot lead ranks. For example, you may wish to designate a score between 
1 to 25 points as a cold lead and a score between 201 and 300 points as a hot 
lead.

The range of values cannot overlap. 

4. Make sure that the Enabled check box is selected for those rank mappings you 
wish to use.

5. Click Save on the toolbar. 

6. Set up required fields for lead qualification:

a. Log in under the System Administrator responsibility.

b. Navigate to Profile > System.

The Find System Profiles window appears.

c. Enter OS%Required in the Profile field.
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d. Click Find.

 The System Profile Values window appears.

e. Setting any of the following profile options to Y requires users to make 
entries in the corresponding fields before a lead can be turned to the status 
of qualified:

* OS: Budget Status Required

* OS: Campaign Code Required

* OS: Contact Phone Required

* OS: Contact Role required

* OS: Decision Time Frame Required

* OS: Project Name Required

* OS: Sales Channel Required

* OS: Total Budget Amount Required

f. Click Save on the toolbar.

Setting Up the Lead Score Card
Use this procedure to modify an existing lead score card or create a new one. A 
score card assigns points to each piece of information entered in a lead and uses the 
sum to assign a rank to that lead. While you can create multiple score cards, you can 
have only one score card enabled at one time. You must enable a score card for the 
whole site.

Steps
1. Under the TeleSales Administrator responsibility, navigate to Lead Scorecard.

2. If you wish to modify an existing lead score card, then use the Description List 
of Values LOV to select a score card.

3. If you wish to create a new score card, then:

a. Enter a new Description.

b. Click Save in the toolbar.

4. If you wish to add a rule:

a. Click Add Rule.
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The Create/Edit Rule window appears.

b. Using the Rule LOV, enter the field you wish to use for the calculation.

The available fields are:

* Organization: name of an organization.

* Campaign code

* Contact role

* Sales channel

* Budget amount

* Time frame

* Budget Status

c. If the field you entered in the previous step requires a range of values, then 
enter the range in the Low Value and High Value fields. 

d. If the field requires only one value, then enter that value in the High Value 
field only.

e. In the Score field, enter the numerical score for this rule. 

f. Click Save.

5. If you wish to edit a rule, then select the rule and click Edit.

Assigning Campaigns to Agents
Use this procedure to assign campaigns to agents. 

Prerequisites
You must be logged in under the TeleSales Administrator responsibility.

Steps
1. Under the TeleSales Administrator responsibility, navigate to Campaign Agent 

Assignment.

The Campaign Agent window appears.

There are two ways of assigning campaigns to agents:
Administering Oracle TeleSales 145



Assigning Campaigns to Agents
■ Assign campaigns to individual agents or sales groups using the Resource 
tab.

■ Assign agents or sales groups to individual campaigns using the Campaign 
tab. 

Both methods achieve the same result.

2. If you wish to assign campaigns to individual agents or sales groups, then:

a. Select the Resource tab.

b. If you wish to assign campaigns to individual agents, then select the 
Resource radio button.

c. If you wish to assign campaigns to sales groups, then select the Resource 
Group radio button.

d. Click Search to the right of the Name field. 

The Teleagent Resource Search window appears.

e. Enter search criteria. 

f. Click Find.

g. Select one of the agents among the list of results which appear below.

h. Click OK to enter the agent and close the search window.

i. Click Find next to the Campaign Name field.

j. All of the available campaigns display on the left side of the window.

k. Use the arrow keys to move the campaigns you wish to assign to the right.

l. When you are done, click OK.

3. If you wish to assign agents or sales groups to campaigns, then:

a. Select the Campaign tab.

b. Click Search to the right of the Name field. 

The Campaign Search window appears.

c. Enter search criteria. 

d. Click Find.

e. Select one of the campaigns in the list of results which appear below.

f. Click OK to enter the campaign and close the search window.
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g. If you wish to assign individual agents to the campaign, then select the 
Resource radio button.

h. If you wish to assign sales groups to the campaign, then select the resource 
group radio button.

i. Click Find next to the Name field.

j. All of the available agents or sales groups appear on the left side of the 
window.

k. Use the arrow keys to move the agents or sales groups you wish to assign to 
the right.

l. When you are done, click OK.

Creating Outcomes, Results, and Reasons for Call Wrapup
Use this procedure to create the categories used to track the outcome of agent calls. 
These categories are used by management to determine agent performance. 

There are three types of categories:

■ Outcomes: Outcomes of the agent activities. For example, the agent makes 
contact, gets a wrong number, leaves a message, or receives a busy signal.

■ Results: The results of the outcomes. For example, the agent makes a sale, or 
fails to make a sale.

■ Reasons: The reasons for the outcomes. For example, the agent makes a sale 
because the price is lower than the competition, or the agent fails to make a sale 
because the customer already has a similar product.

An outcome can have multiple results and a result can have multiple reasons. 

After you finish creating the outcomes, results, and reasons, you must link them 
together using the Outcome Result Reason Assignment window. 

Prerequisites
You must be logged in under the TeleSales Administrator responsibility.

Steps
1. Under the TeleSales Administrator responsibility, navigate to Call Wrapup 

Administration.

The Call Wrapup Administration window appears.
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2. Set up the possible outcomes of agent call interactions. For each outcome:

a. Select the Outcome tab.

b. Enter a short code and a short description for the outcome. Both the code 
and the outcome description are visible to the agent in the List of Values. 
However, the agent can search only on the code.

c. If your site is using Advanced Outbound and you wish to recycle calls, you 
must make a numerical entry in the Legacy Code field. See Oracle Predictive 
Concepts and Procedures

d. Enter the score and media type. These are free-form text fields. See the 
Implementing Oracle Interaction History section of the Oracle CRM 
Foundation Implementation Guide for details.

e. Optionally select the following check boxes:

* Positive: Includes this outcome in reports and queries.

* Result Required: Requires the agent to select a result for this outcome.

* Generate Public Callback: The callback can be rerouted to any agent.

* Generate Private Callback: Generates a callback for the agent who 
called the customer. 

f. Optionally, enter a description. This description is for administrative 
purposes only and does not appear in the user interface.

g. Click OK to save the outcome.

h. If you wish to enter another outcome, then click New and repeat this 
procedure.

3. Enter the reasons for the outcome you created in the previous step. For each 
result:

a. Select the Results tab.

b. Enter a short code and a short description for the result. Both the code and 
the outcome description are visible to the agent in the List of Values. 
However, the agent can search only on the code.

c. If your site is using Advanced Outbound and you wish to recycle calls, you 
must make a numerical entry in the Legacy Code field. See Oracle Predictive 
Concepts and Procedures.
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d. Enter the score and media type. These are free-form text fields. See the 
Implementing Oracle Interaction History section of the Oracle CRM 
Foundation Implementation Guide for details.

e. Optionally select the following check boxes:

* Positive: Includes this result in reports and queries.

* Reason Required: Requires the agent to select a reason for this result. 

* Generate Public Callback: The callback can be rerouted to any agent.

* Generate Private Callback: Generates a callback for the agent who 
called the customer. 

f. Optionally, enter a description. This description is for administrative 
purposes only and does not appear in the user interface.

g. Click OK to save the result.

h. If you wish to enter another result, then click New and repeat this 
procedure.

4. Create the reasons for the results you have created. For each reason:

a. Select the Reason tab.

b. Enter a short code and a short description for the reason. Both the code and 
the reason description are visible to the agent in the List of Values. 
However, the agent can search only on the code.

c. If your site is using Advanced Outbound and you wish to recycle calls, you 
must make a numerical entry in the Legacy Code field. See Oracle Predictive 
Concepts and Procedures.

d. Enter the score and media type. These are free-form text fields. See the 
Implementing Oracle Interaction History section of the Oracle CRM 
Foundation Implementation Guide for details.

e. Optionally, select the following check boxes:

* Generate Public Callback: The callback can be rerouted to any agent.

* Generate Private Callback: Generates a callback for the agent who 
called the customer. 

f. Optionally, enter a description. This description is for administrative 
purposes only and does not appear in the user interface.

g. Click OK to save the reason.
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h. If you wish to enter another reason, then click New and repeat this 
procedure.

Linking Outcomes to Results and Reasons
Use this procedure to link together the outcomes, results and reasons you have 
created in the previous step.

Prerequisites
You must be logged in under the TeleSales Administrator responsibility.

Steps
1. Under the TeleSales Administrator responsibility, navigate to Outcome Result 

Reason Assignment.

The Outcome Result Reason Assignment window appears. The window is 
divided into three panes displaying all of the outcomes, results, and reasons 
you have created.

2. Assign the results for each outcome:

a. Select the Current Record Indicator to the left of the outcome. This is the 
narrow unlabeled field to the left of the Code field.

b. Select the Assign check boxes for the results to be associated with the 
outcome.

c. Click Save in the toolbar.

3. Assign the reasons for each result:

a. Select the Current Record Indicator to the left of the result. This is the 
narrow unlabeled field to the left of the Code field.

b. Select the Assign check boxes for the reasons to be associated with the 
outcome.

c. Click Save in the toolbar.

Guidelines
If you wish to add any additional outcomes, results, or reasons, click New and 
make your entry in the Call Wrapup Administration window using the procedure 
described in Create Outcomes, Results, and Reasons for Call Wrapup. 
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Clicking the Details button displays the details of the selected outcome, result, or 
reason.

 Assigning Outcomes to Campaigns
Use this procedure to assign outcomes to campaigns. Different campaigns require 
different outcomes. For example, you may wish to use "leave message" as an 
outcome for a customer satisfaction campaign, but not for a sales campaign. 

Steps
1. Under the TeleSales Administrator responsibility, navigate to Campaign 

Outcome Assignment.

The Campaign Outcome Assignment window appears.

2. Select the campaign using the Campaign List of Values (LOV).

3. Assign the outcomes to the campaign by moving the outcomes from the 
Available to the Assigned list using the arrow keys. For each outcome:

a. In the Available region, select the outcome.

b. Click the up arrow button.

The outcome is added to the list in the Assigned region.

4. Click Save on the toolbar.

Guidelines
If you wish to add any additional outcomes, results, or reasons, click New and 
make your entry in the Call Wrapup Administration window using the procedure 
described in Create Outcomes, Results, and Reasons for Call Wrapup. Remember 
that you must link any new results and reasons to outcomes before you can use 
them.

Clicking the Details button displays the details of the selected outcome, result, or 
reason.
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Enabling Web Directory Assistance
Implementing Oracle TeleSales

This group of topics relates to the implementation of Oracle TeleSales. For a 
complete list of implementation steps, see the Oracle TeleSales Implementation Guide.

Enabling Web Directory Assistance
Use this procedure to enable web directory assistance for agents. 

Steps
1. Under the TeleSales Administrator responsibility, navigate to Directory 

Assistance Administration.

The Web Directory Assistance Administration window appears.

2. Using your browser, navigate to the web directory assistance service you wish 
to use

3. Perform a search for any individual. For example, for John Doe in California.

Keep the page with the results open. You will need to refer to it for the rest of 
this procedure.

For example, navigate to www.superpages.com, select the People Pages tab, 
and search for John Doe in California.

The search returns a page with the following URL:

http://wpg2.superpages.com/wp/results.phtml?SRC=&STYPE=WS&PS=15&PI=1&WF=John
&WL=Doe&T=&S=CA&search=Find&pow=0&rtd=wpg1.superpages.com

4. In the Proxy Host field, enter the name of your organization’s proxy server.

5. In the Port field, enter the port number for the proxy server.

6. In the Search URL field, enter the part of the URL before the delimiter.

In the SuperPages.com example, the delimiter is ? so you enter: 
http://wpg2.superpages.com/wp/results.phtml

7. In the CGI Server field, enter your name for this service. This is a free-form text 
field.
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8. In the Next Page ID field, enter the text of the hypertext link that indicates the 
next page. You are entering the link text as the user sees it; not the HTML 
source. The text is case sensitive.

For example, in SuperPages.com that text is Next.

9. In the Max Pages field, enter the maximum number of pages of results you wish 
Oracle TeleSales to parse.

10. Select the Enabled check box. 

11. Enter the CGI switch separator.

In the SuperPages.com example this is &.

12. In the Header Constant field, enter the part of the CGI portion of the URL 
header that remains constant. This is the portion that you made no entries in.

In the SuperPages.com example this is: SRC=&STYPE=WS&PS=15&PI=1.

13. In the Trailer Constant field, enter the constant part of the URL after the search 
terms.

In the SuperPages.com example this is: 
&search=Find&pow=0&rtd=wpg1.superpages.com.

14. Click CGI Switches.

The CGI Switches window appears.

15. Enter information on each of the switches. The switches are the CGI script 
variables used for your search criteria. In the SuperPages.com example these 
are: WF, WL, T, and S. For each switch:

a. Enter the switch in the Code field. The entry is case sensitive.

b. Enter the Data Separator. For SuperPages.com this is =.

c. Enter a number indicating the order this switch appears in the URL.

d. If user entry for this switch is required, then select the Required check box.

Note: You can enable only one service at a time.

Note: You may need to perform additional searches to determine 
what portion of the URL remains constant. 
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e.  Select the appropriate check box to indicate the search criteria this switch is 
used for. For SuperPages.com WF is used for first name, WL for last name, 
T for city, and S for state.

16. When you are finished entering the CGI switches, click Save on the toolbar

17. Click Close.

Enabling Directory Assistance
Use this procedure to enable the agent dialing of directory assistance numbers. You 
can set up multiple directory assistance numbers.

Steps
1. Under the TeleSales Administrator responsibility, navigate to Phone Directory 

Assistance Administration.

The Phone Directory Assistance Administration window appears.

2. Enter information about the directory assistance services. For each service:

a. In the Name and Description fields, enter the name and description of the 
service. These are visible to the agents.

b. In the Country Code field, enter the country code for the country this 
service is in. If the country is the United States, then enter 01.

c. In the Phone Number field, enter the phone number. Any standard format 
is acceptable, for example: 555-1212.

d. Enter an extension, if any.

e. Make sure the Enabled check box is selected.

3. Click Save on the Toolbar.
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